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CHƢƠNG 1: NHỮNG PHẦN MỀM TRONG XÂY DỰNG 

1.1. Phần mềm tính toán kết cấu 

1.1.1. Các phần mền tính Kết Cấu  

Các phần mềm của hãng CSI   

CSI là một hãng rất nổi tiếng về phần mềm tính toán kết cấu dựa trên lý thuyết về phần tử 

hữu hạn. 

Nhóm các phần mềm CSI gồm : 

- CSI Sap2000 : Tính toán các công trình kể cả các công trình đặc biệt như silo, tháp 

nước, dàn thép, dàn không gian, cầu,.... 

- CSI Col : Tính toán cột, với các loại tiết diện tròn, hình chữ nhật. Tính toán cột lệch tâm 

xiên 

- CSI Etabs : Chủ yếu dùng để tính toán nhà cao tầng. 

- CSI Safe : Tính toán bản sàn. Với tất cả các lọai sàn dựa trên gối cứng, gối mềm,... 

- CSI Section Builder : Dùng để thiết kế các loại tiết diện đặc biệt không có sẵn trong Sap. 

Sau đó ghi lại dưới dạng các file *.Pro rồi được Export sang cho các phần mềm khác của 

hãng. 

Việc tính toán bao gồm : 

- Thiết kế mô hình tính toán, các điều kiện biên. 

- Nhập các số liệu tiết diện, tải trọng. 

- Xác định các trường tổ hợp tải trọng 

- Xác định phương pháp tính toán khảo sát. 

- Tính toán nội lực và thiết kế thép theo tiêu chuẩn ACI, Eurocode, BS. 

- Các phần mềm CSI có thể xuất dữ liệu sang nhau. 

Đánh giá: Bộ chương trình của hãng CSI khá tốt, kết quả tương đối chuẩn, được sử dụng 

rộng rãi trên thế giới. 

Staad Pro 

Là phần mềm của hãng ENGINNER RESEARCH CORPORATION nhằm phần tích, 

thiết kế kết cấu trong xây dựng. Việc phân tích kết cấu được lập trên cơ sở phương pháp 

phần tử hữu hạn, còn việc thiết kế tuân theo các tiêu chuẩn và quy phạm được lựa chọn. 

Staad Pro có khả năng rất mạnh trong phân tích và thiết kế các cấu kiện với nhiều dạng 

kết cấu khác nhau (hệ khung phẳng, khung không gian, kết cấu sàn vách....)chịu nhiều 

dạng tải trọng khác nhau (tải trọng bản thân,gió, tải trọng động và tải trọng động đất) 

Một số chức năng nổi trội của Staad Pro : 

-Xác định chu kỳ dao động riêng, tần số dao động riêng và các dụng dao động riêng khác 
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của kết cấu. 

-Loại bỏ một số phần tử khi phân tích. Staad Pro có tùy chọn Ignore (inactive) một số 

phần tử khi phân tích, khi đó độ cứng các phần tử này sẽ không được kể vào ma trận độ 

cứng tổng thể của cả hệ kết cấu. 

-Tạo bản sàn cứng tuyệt đối : trong kết cấu nhà cao tầng, độ cứng trong mặt phẳng của 

các bản sàn được coi là tuyệt đối cứng vô cùng khi lựa chọn là (Slaver/ Master). 

Xsteel: Là phần mềm hỗ trợ vẽ thép. 

Plaxis và Geo slope 

Plaxis và Geo slope là 2 phần mềm dùng để tích nền đất. 

Geo slope gồm 5 module tính ứng suất, biến dạng, trượt, thấm, động đất và vận chuyển ô 

nhiễm trong đất. 

Bài toán chủ yếu là tính tường chắn, lún, đê đập và vận chuyển chất thải trong đất. 

Số liệu nhập vào là các lớp đất, các chỉ số cơ lý của đất như phi, C, gama và mực nước 

ngầm. 

MCW 

Chương trình tính toán và thiết kế móng cọc Công ty : CIC bộ Xây Dựng. 

Tính năng : 

-Vào các chỉ tiêu cơ lý của đất, các số liệu từ xuyên tĩnh, xuyên TC, thí nghiệm cọc nén 

tại hiện trường. 

-Vào các số liệu về cọc, đài cọc 

-Chương trình sẽ tự tính toán dự báo sức chịu tải của cọc, bố trí cọc trong đài. Tính toán 

thiết kế đài cọc, đọ lún tổng thể và cường độ lớp đất dưới mũi cọc. 

-Xuất sang file DXF bản vẽ thép và bảng thống kê thép. 

MDW 

Chương trình tính toán và thiết kế móng đơn. 

Công ty : CIC bộ Xây Dựng. 

Tính năng : 

-Thiết kế và kiểm tra móng đơn khi có số liệu về địa chất 

-Vào lực tác dụng lên móng (M,N,Q) 

-Chương trình tính toán khả năng chịu tải của nền và tính toán móng theo hai trạng thái 

giới hạn về cường độ và về biến dạng. 

-Kết quả tính toán được thể hiện dưới dạng text or graphic (AutoCad) 

MBW 

Chương trình tính toán và thiết kế móng băng giao nhau. 
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Công ty : CIC bộ Xây Dựng. 

Tính năng : 

-Mô hình hoá bài toán dầm trên nền đàn hồi. Sử dụng phương pháp PTHH để tính toán 

chuyển vị và nội lực trong KC. 

-Dễ nhập tải, bao gồm tất cả các loại tải trọng. 

-Thiết kế với các dạng dầm chữ I,T,C… 

-Xuất bản vẽ thi công với các mặt cắt, chi tiết dầm, bảng thống kê cốt thép,... sang môi 

trường AutoCad. 

KPW 

Chương trình phần tử hữu hạn tính toán kết cấu khung phẳng BTCT theo TCVN 2737-

1995 

Công ty : CIC bộ xây dựng. 

Tính năng : 

-Nhập khung và tải trọng trong môi trường đồ hoạ 

-Nhập tải trọng theo các dạng phân bố đều, tải hình thang, tam giác và tự động dồn tải 

trọng gió tĩnh. 

-Tích hợp nhiều thư viện vật liệu bêtông cốt thép, các loại tiết diện thép theo TCVN. 

Tính nội lực, tự tổ hợp nội lực và tính thép theo TCVN. 

-Xuất bản vẽ thi công sang AutoCAD, tuy nhiên còn phải sửa nhiều mới dùng được. 

Xuất kết quả nội lực, vẽ biểu đồ bao nội lực. 

Đánh giá : 

-Không xuất được khung tính toán ra CAD, cũng như file ảnh. 

-Môi trường đồ hoạ chưa được tốt lắm. 

VinaSAS 

Chương trình phần tử hữu hạn tính toán kết cấu khung không gian BTCT theo TCVN 

2737-1995. 

Công ty : CIC bộ xây dựng. 

Tính năng : 

-Nhập sơ đồ và tải trọng trong môi trường đồ hoạ 

-Tự động dồn tải trong gió tĩnh 

-Tính toán nội lực và chuyển vị theo TCVN theo phương pháp phân tích độ cứng. 

-Tính toán thép theo TCVN 2737-95 

-Xuất bản vẽ thi công ra CAD, Kết quả theo sơ đồ biểu đồ bao nội lực, tạo báo cáo cho 

từng cấu kiện được chọn. 
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RDW 

Chương trình tổ hợp nội lực, thiết kế, kiểm tra cấu kiện BTCT và thép theo TCVN từ kết 

quả tính toán của các phần mềm SAP90, SAP 2000, STAAD III, STAAD PRO.  

Công ty : CIC Bộ xây dựng. 

Tính năng : 

-Lấy KQNL từ SAP, STAAD, tổ hợp NL theo TCVN 2737-95 

-Có thể tổ hợp các trường hợp tải trọng đặc biệt như gió động, động đất, gió xiên,... 

-Đưa ra biểu đồ bao NL lực dọc, lực cắt, moment và đưa ra các tổ hợp NL nguy hiểm tại 

các mặt cắt. 

-Sau đồ thiết kế cấu kiện BTCT theo TCVN 356-2006. Kiểm ta nứt và võng với các cấu 

kiện nhịp lớn. Dưa ra bản vẽ thi công sang CAD. 

-Thiết kế kiểm tra cấu kiện thé p theo TCVN 5575-91. Thực hiện kiểm khả năng chịu lực 

tại các vị trí mặt cắt. Ngoài ra còn tra ổn đinh cục bộ, ổn định tổng thể và chuyển vị ngang 

của toàn bộ KC. Tính toán TK các nút, các liên kết cột với móng thép (bu lông, đường 

hàn) 

-Ngoài ra còn module thư viện thiết kế : BTCT, cột, vách, dầm thép góc, dàn thép góc, 

sàn BTCT thường và ứng lực trước. 

-Thể hiện ra các bản vẽ TC tương đối chuẩn (tuy nhiên vẫn phải sửa lại cho theo ý muốn) 

VN3D 3.0 

Chương trình phần tử hữu hạn tính kết cấu không gian theo TCVN 2737/95. 

Công ty : Hài Hoà  

Tính năng : 

-Nhập, chỉnh sửa số liệu trực tiếp trên màn hình đồ hoạ. 

-Thư viện các phần tử : Thanh, khối, vỏ. 

-Tính toán chuyển vị, nội lực, dao dộng riêng của kết cấu. 

-Tính toán cốt thép cho từng cấu kiện. 

TKT 3.0 

Phần mềm thống kê cốt thép chạy trong môi trường AutoCad  

Công ty : Hài Hoà. 

Tính năng : 

-Vẽ tiết diện BTCT với bảng các thông số. 

-Tạo chỉ dẫn cốt thép. 

-Lập và tự động cập nhật bảng thông kê thép. 

-Lập bảng tổng hợp cốt thép từ các bảng thống kê thép. 
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Nhận xét : 

KIW 

Chương trình tính và thiết kế khung thép tiền chế chữ I  

Công ty : CIC bộ Xây Dựng  

Tính năng : 

-Nhập số liệu vào rất đơn giản. 

-Kiểm tra hoặc thiết kế, cho phép xác định tiết diện tối ưu bằng phương pháp lặp. (gọi 

chương trình staad để chạy nội lực, chương trình sẽ lấy KQ này để tính thép) 

-Xuất kết quả ra CAD (khung bản vẽ, các chi tiết liên kết, bảng thống kê VL,...). 

SPTW 

Chương trình tính sàn BTCT Công ty : CIC bộ Xây Dựng 

Tính năng : 

-Tính toán sàn theo phương pháp đàn hồi. 

-Tạo mặt cắt cốt thép rất linh hoạt. 

-Xuất bản vẽ thi công sang môi trường đồ hoạ. 

1.1.2. Phần mền Etabs. 

a) Giới thiệu. 

- Đã phát triển hơn 40 năm. 

- Khả năng lớn. 

- Tính theo phần tử hửu hạn. 

- Dễ sử dụng. 

- Chuyên môn hoá. 

b) Cài đặt  

- Chạy thư mục cài đặt. 

- Crack: Tuỳ theo phiên bản 

c) Giao diện.  

-Dễ sử dụng, các về sau tính dễ sử dụng được nâng cao so với các verson trước. 

1.2.Các phần mềm khác. 

Phần mềm Projet 

Là phần mềm dùng để thiết lập và quản lý tiến độ dự án của hãng Microsoft.  

Tính năng : 

-Thể hiện tổng chi phí vật liệu, nhân công, máy khi nhập tiên lượng. 

-Tính cước vận chuyển đường sông, đường bộ, vận chuyển thủ công. 

-Lập tổng dự toán 
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-Tìm kiếm theo mã hoặc theo tên. Tra cứu trực tiếp đơn giá theo mã, tên. Với 61 bộ đơn 

giá của cả nước. 

-Thể hiện KQ tính toán trên màn hình và Word, Excel. 

-Có thể in các loại bản in trực tiếp trong chương trình. 

Dự toán - dự thầu G8 

 Phần mềm dự toán G8 thuộc Công ty cổ phần Công nghệ Hoàng Hà. Một chương 

trình được sử dụng nguồn từ CSDL là hệ thống định mức kết hợp với đơn giá sẽ giúp rút 

ngắn thời gian và chi phí rất đáng kể cho các kỹ sư kinh tế trong việc bóc tách tiên lượng, 

lập dự toán xây dựng công trình. 

-Giao diện thân thiện giống phần mềm Microsoft Excel 

-Có nhiều cách chiết tính, dự thầu phục vụ cho việc làm thầu của doanh nghiệp 

-Có khả năng xuất sang Microsoft Excel với đầy đủ công thức, định dạng, v.v... 

-Có khả năng lấy tiên lượng dự toán từ bất kỳ 1 dự toán nào như dự toán 97 năm 

1997,......năm 2020 hoặc tiên lượng làm trên Excel 

-Lập tiến độ thi công, ghi bản vẽ sang Autocad. 

-Có khả năng thẩm định công ttrình để tìm ra sự sai lệch về khối lượng, đơn giá, định mức 

-Có khả năng kết nối các tiên lượng lại thành 1 tiên lượng duy nhất. 

-Dùng đa đơn giá, đa hạng mục trong 1 công trình mà không cần tách 1 hạng mục thành 1 

file như các phần mềm dự toán khác  

-Cơ sở dữ liệu hiệu chỉnh dễ dàng, trực quan và đặc biệt là có đủ đơn giá, định mức của 

64 Tỉnh, Thành phố. 

Phần mềm Revit 

 Revit là phần mềm được nghiên cứu và phát triển bởi hãng Autodesk (người cha đẻ 

của các phần mềm nổi tiếng, trong đó có AutoCAD). Là một phần mềm mạnh mẽ hỗ trợ 

cho các kiến trúc sư, kỹ sư xây dựng. Revit được xây dựng đặc biệt cho Building 

Information Modeling (BIM), trao quyền cho các chuyên gia thiết kế và xây dựng những 

ý tưởng từ ý tưởng đến xây dựng với một cách tiếp cận dựa trên mô hình phối hợp và nhất 

quán. Revit là một ứng dụng duy nhất mà bao gồm các tính năng cho thiết kế kiến trúc, 

MEP và kỹ thuật kết cấu và xây dựng.. 

 Revit trình bày thông minh các thiết kế dược dạng một loạt vật thể và những vật 

thể này đều có tham số. Thông tin này được lưu trữ trong một mô hình duy nhất và bạn có 

thể trích xuất không hạn chế số lượng góc nhìn từ những dữ liệu đã có sẵn của mô hình 

này. Cụ thể là bất kì một sự thay đổi nào sẽ kéo theo các mối quan hệ tương ứng khác 

cũng thay đổi toàn bộ dự án một cách tự động và đồng bộ (góc nhìn, bảng thống kê, mặt 

http://phanmemg8.vn/
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cắt, mặt bằng,…) 

Phần mềm Sketchup 

 SketchUp là một phần mềm mô hình hóa 3D, dành cho các kiến trúc sư, các kỹ sư, 

nhà phát triển trò chơi điện tử, các đạo diễn điện ảnh và các ngành nghề có liên quan. 

Phần mềm này khởi đầu được phát triển bởi công ty @Last Software, có trụ sở 

tại Boulder, Colorado, Mỹ. Phần mềm này nổi bật như một công cụ diễn tả ý tưởng đơn 

giản, nhanh gọn với giao diện đồ họa cho người sử dụng. 

 Một vài đặc điểm nổi bật: 

-Không cần phần cứng mạnh như các phần mềm mô hình hóa khác như 3D 

Max, FormZ, Maya. 

-Hệ thống giao diện với con trỏ đồ họa thông minh cho phép người sử dụng dựng hình vẽ 

ba chiều trong không gian hai chiều của màn hình. 

-Các mặt, diện (face) được định nghĩa đơn giản dựa trên một miền khép kín. 

-Tạo khối đơn giản nhanh gọn bằng công cụ "kéo-đẩy" (push-pull tool) 

-Công cụ chỉnh sửa khối (extrude - widen) và tạo khối theo đường sinh cho trước (follow 

me tool) 

-Khả năng cho phép mô phỏng, hiệu chỉnh góc chiếu của mặt trời vào tất cả các thời điểm 

trong năm cũng như bao quát các góc nhìn cho hiệu quả gần như tức thời. 

-Bản vẽ được kết xuất (render) ở tốc độ cao dựa trên tốt giản hệ mô hình đa giác thấp 

(low-poly), có phong cách trình bày độc đáo. 

-Khả năng giao tiếp rộng rãi với các phần mềm mô hình khác. 

-Có thể kết hợp với các trình kết xuất ngoài (Renderer) để cho ra những hình ảnh tốt hơn 

(etc. IRender, Podium, Indigo, Kerkythea...) 

Ngoài ra còn một số phần mềm khác được phát triển liên tục theo thời đại mà tác giả 

chưa kịp cập nhật. 

 

 

  

https://vi.wikipedia.org/w/index.php?title=Ph%E1%BA%A7n_m%E1%BB%81m_m%C3%B4_h%C3%ACnh_h%C3%B3a_3D&action=edit&redlink=1
https://vi.wikipedia.org/wiki/Ki%E1%BA%BFn_tr%C3%BAc_s%C6%B0
https://vi.wikipedia.org/wiki/K%E1%BB%B9_s%C6%B0
https://vi.wikipedia.org/wiki/Tr%C3%B2_ch%C6%A1i_%C4%91i%E1%BB%87n_t%E1%BB%AD
https://vi.wikipedia.org/w/index.php?title=@Last_Software&action=edit&redlink=1
https://vi.wikipedia.org/wiki/Boulder,_Colorado
https://vi.wikipedia.org/w/index.php?title=Giao_di%E1%BB%87n_%C4%91%E1%BB%93_h%E1%BB%8Da&action=edit&redlink=1
https://vi.wikipedia.org/w/index.php?title=3D_Max&action=edit&redlink=1
https://vi.wikipedia.org/w/index.php?title=3D_Max&action=edit&redlink=1
https://vi.wikipedia.org/w/index.php?title=FormZ&action=edit&redlink=1
https://vi.wikipedia.org/wiki/Maya
https://vi.wikipedia.org/wiki/Thi%E1%BA%BFt_b%E1%BB%8B_hi%E1%BB%83n_th%E1%BB%8B
https://vi.wikipedia.org/wiki/K%E1%BA%BFt_xu%E1%BA%A5t_%C4%91%E1%BB%93_h%E1%BB%8Da
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CHƢƠNG 2: KIẾN THỨC CƠ BẢN VỀ ETABS 

2.1. Các thanh công cụ (Toolbars) trong Etabs  

Trong ETABS có các thanh công cụ giúp người sử dụng có thể thao tác nhanh các lệnh 

thông qua các biểu tượng đặc trưng nằm trên đó. Các thanh công cụ có thể bật/tắt theo ý 

người sử dụng. 

Cách bật/tắt được thể hiện bằng cách: 

- Thao tác thực hiện: 

Chuột phải lên chỗ trống thanh Trình đơn (Menu Bar)  Chọn các thanh công cụ cần 

thao tác. 

1. Main : 

 

Biểu 

tƣợng 
Tên tiếng Anh Ý nghĩa 

 New Model (Ctrl+N) Tạo một bài toán mới 

 Open (Ctrl+O) Mở một bài toán đã có 

 Save (Ctrl+S) Lưu bài toán 

 Print Graphics (Ctrl+P) In các màn hình đồ họa 

 Print Input Tables… In số liệu và kết quả bài toán 

 Undo (Ctrl+Z) Hủy bỏ lệnh trước đó 

 Redo (Ctrl+Y) Lấy lại lệnh vừa hủy bỏ 

 Refresh Window Làm sạch màn hình đồ họa 

/ 

 

Lock/Unlock Model Khóa/Mở khóa kết cấu 

 Run Analysis(F5) Phân tích kết cấu 

 Rubber Band Z0om (F2) Phóng to kết cấu theo cửa số xác định 

 Restore Full View (F3) Xem toàn bộ kết cấu 

 Restore Previuos Zoom Lấy lại lệnh Zoom trước đó 

 Zoom In One Step Phóng to kết cấu theo từng bước 

 Zoom Out One Step Thu nhỏ kết cấu theo từng bước 

 Pan (F8) Dịch chuyển quan sát kết cấu  
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2. View : 

 

Biểu 

tƣợng 
Tên tiếng Anh Ý nghĩa 

 Show Joints Bật/tắt các đối tượng nút 

 Show Frames Bật/tắt các đối tượng thanh 

 Show Shells Bật/tắt các đối tượng tấm vỏ 

 Show Grid (F7) Bật/tắt hệ lưới 

 Show Axes Bật/tắt hệ tọa độ tổng thể 

 Show selection Only Chỉ thể hiện được chọn 

 Show All Hiển thị tất cả các đối tượng 

3. Edit : 

 

Biểu 

tƣợng 
Tên tiếng Anh Ý nghĩa 

 Cut (Ctrl+X) Cắt nhóm đối tượng được chọn 

 Copy (Ctrl+C) Sao chép nhóm đối tượng 

 Paste (Ctrl+V) Dán nhóm đối tượng 

 Set Default 3D View Quan  sát không gian kết cấu  

 Set Plane View Quan sát mặt bằng kết cấu 

 Set Elevation View Quan sát mặt đứng kết cấu 

 Rotate 3D View Xoay kết cấu trong cửa sổ 3D 

 Perspective Toggle Quan sát phối cảnh kết cấu 

 Move Up in List Dịch chuyển lên một bước lưới 

 Move Down in List Dịch chuyển xuống một bước lưới 

 Object Shrink Toggle Quan sát kết cấu dạng thu ngắn 

 Set Building View Options Thiết lập các thông số hiển thị 

 Assign Group Names Khai báo nhóm các đối tượng 
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 Delete (Delete) Xóa nhóm đối tượng được chọn 

 Replicate 
Sao chép đối tượng theo tùy chọn 

khác nhau 

 Edit Grid Data Chỉnh sửa lưới mặt bằng 

 Edit Story Data Chỉnh sửa các lưới tầng 

 Merge Points Gộp các nút nằm gần nhau 

 Align Points/Lines/Edges Hiệu chỉnh nút, thanh, biên đối tượng 

 Move Points/Lines/Areas Di chuyển nút, thanh, tấm vỏ 

 Expand/Shrink Area Phóng to hay thu nhỏ đối tượng vùng 

 Merge Areas Gộp phần tử tấm vỏ 

 Mesh Areas Chia phần tử tấm vỏ 

 Joint Lines Gộp phần tử thanh 

 Divide Lines Chia phần tử thanh 

 Extrude Points to Lines Hiệu chỉnh nút tới đối tượng thanh 

 Extrude Lines to Areas Hiệu chỉnh thanh tới đối tượng tấm vỏ 

4. Point and Joints Assigns : 

 

Biểu 

tƣợng 
Tên tiếng Anh Ý nghĩa 

 Diaphragm  Gán liên kết màng cứng cho nút 

 Assign Panel Zone Gán kiểu Panel Zone 

 Assign Restraints (Supports) Gán điều kiện biên (nút) 

 Assign Point Springs Gàn liên kết đàn hồi 

 Assign Link Properties Gán liên kết đặc trưng 

 Assign Additional Point Mass Gán khối lượng nút 

 Assign Force Gán tải trọng cho nút 

 Assign Ground Displacement Gán tải trọng chuyển vị nút 

 Assign Point Temperature Gán tải trọng nhiệt độ cho nút 

5. Frame and Line Assigns : 
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Biểu 

tƣợng 
Tên tiếng Anh Ý nghĩa 

 Assign Frame Section Gán tiết diện thanh 

 
Assign Frame Releases/Partial 

Fixity 
Gán giải phóng liên kết 

 Assign Frame End (Length) Offsets Gán vùng cứng phần tử thanh 

 Assign Frame Output Station Gán số mặt cắt phần tử thanh 

 Assign Frame Local Axes Gán trục địa phương phần tử thanh 

 Assign Line Springs Gán liên kết đàn hồi thanh 

 Assign Additional Line Gán khối lượng riêng của thanh 

 Assign Point Load Gán tải tập trung trên thanh 

 Assign Frame Distributed Load Gán tải trọng phân bố trên thanh 

 Assign Frame Temperature Gán tải trọng nhiệt độ trên thanh 

6. Draw : 

 

Biểu 

tƣợng 
Tên tiếng Anh Ý nghĩa 

 Select Object Con trỏ chuột đối tượng 

 Reshape Object Thay đổi tọa độ nút 

 Draw Point Objects Vẽ nút (điểm) 

 Draw Line (Plan, Elev, 3D) Vẽ thường phần tử thanh 

 
Creat Line in Region or at Clicks 

(Plan, Elev, 3D) 
Vẽ nhanh phần tử thanh 

 
Creat Colunm in Region or at 

Clicks (Plan) 
Vẽ phần tử cột theo vùng xác định 

 
Creat Secondary Beams  in Region 

or at Clicks (Plan) 
Vẽ hệ dầm phụ 

 Creat Braces in Region or at Clicks Vẽ hệ thanh giằng 
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(Elev) 

 Draw Areas (Plan, Elev, 3D) Vẽ phần tử sàn qua 3, 4 diểm 

 
Draw Rectangular Area (Plan, 

Elev) 
Vẽ thường phần tử sàn 

 Creat Areas at Click (Plan, Elev) Vẽ nhanh phần tử sàn 

 Draw Walls (Plan) Vẽ thường phần tử vách cứng 

 
Creat Walls in Region or at Click 

(Plan) 
Vẽ nhanh phần tử vách cứng 

 
Draw Developed Elevation 

Definition 
Vẽ mặt cắt kết cấu  

 Draw Dimention Line Do kích thước phần tử 

 Draw Reference Point Vẽ điểm tham chiếu 

7. Shell and Area Assigns : 

 

Biểu 

tƣợng 

Tên tiếng Anh Ý nghĩa 

 Assign Wall/Slab/Deck Section Gán tiết diện cho phần tử 

 Assign Opening Gán tấm có lỗ trống 

 Diaphragms Gán màng cứng phần tử tấm 

 Assign Shell Local Axes Gán trục địa phương phần tử tấm vỏ 

 Assign Pier Label Gán tên cho đối tượng Pier 

 Assign Spandrel Label Gán tên cho đối tượng Spandrel 

 Assign Area Springs Gán liên kết đàn hồi cho phần tử tấm vỏ 

 Assign Additional Area Mass Gán khối lượng riêng cho phần tử tấm vỏ 

 Assign Uniform Load Gán tải trọng phân bố cho phần tử tấm vỏ 

 Assign Shell Temperature Gán tải trọng nhiệt độ cho phần tử tấm vỏ 

8. Display : 
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Biểu 

tƣợng 

Tên tiếng Anh Ý nghĩa 

 Show Undeformed Shape 
Xem hình dạng ban đầu sau khi giải bài 

toán xong 

 Show Deformed Shape Xem kết quả chuyển vị 

 Show Mode Shape Xem kết quả phân tích Mode Shape 

 

Show Member Forces/Stress 

Diagram 

Xem kết quả về nội lực (phản lực, dầm 

– cột, ứng suất – nội lực trong sàn) 

 Show Joint/Point Xem tải trọng về nút 

 Show Frame/Line Xem tải trọng về phần tử thanh 

 Show Shell/Area Xem tải trọng về phần tử tấm vỏ 

 Show Tables Xem kết quả dưới dạng bảng 

9. Select : 

 

Biểu 

tƣợng 

Tên tiếng Anh Ý nghĩa 

 Select All (Ctrl+A) Chọn tất cả các đối tượng 

 Get Previous Selection Lấy lại một đối tượng được chọn 

 Clear Selection Xóa tất cả các đối tượng được chọn 

 Select using Intersecting Line 
Chọn đối tượng bằng đường Line 

(đường băng) 

10. Snap : 

 

Biểu 

tƣợng 

Tên tiếng Anh Ý nghĩa 

 
Snap to Grid Intersections and 

Point 

Bắt điểm tại các nút và vị trí lưới giao 

nhau 

 Snap to Line Ends and Midpoints 
Bắt điểm tại điểm giữa và vị trí đầu 

cuối 
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 Snap to Intersections Bắt điểm tại vị trí  giao nhau 

 Snap to Perpendicular Projections Bắt điểm theo hướng vuông góc 

 Snap to Lines and Edges Bắt điểm theo đường và cạnh 

 Snap to Fine Grid Bắt điểm theo hệ lưới kết cấu 

11. Define : 

 

Biểu 

tƣợng 

Tên tiếng Anh Ý nghĩa 

 Define Material Properties Khai báo đặc trưng vật liệu 

 Define Frame Sections Khai báo tiết diện cho phần tử thanh 

 Define Wall/Slab/Deck Sections 
Khai báo tiết diện cho phần tử tấm vỏ 

(vách, sàn, lõi cứng) 

 Define Link Properties Khai báo đặc trưng phần tử phi tuyến 

 Response Spectrum Functions 
Định nghĩa hàm phổ gia tốc (bài toán 

có tính đến động đất) 

 Time History Functions 

Định nghĩa hàm tải trọng thay đổi theo 

thời gian (bài toán có tính đến động 

đất) 

 Define Static Load Case Khai báo các trường hợp tải trọng 

 Define Response Spectrum Case 
Khai báo các trường hợp tải hàm phổ 

gia tốc 

 Define Time History Case 
Khai báo các trường hợp tải thay đổi 

theo thời gian 

 Define Load Combinations Khai báo các tổ hợp tải trọng 

 Define Mass Source 
Khai báo khối lượng để phân tích 

Mode Shape 

12. Design : 

 

Biểu Tên tiếng Anh Ý nghĩa 
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tƣợng 

 
Start Steel Design/Check of 

Structure 
Thiết kế hoặc kiểm tra cấu kiện Thép 

 
Start Concrete Design/Check of 

Structure 
Thiết kế hoặc kiểm tra cấu kiện Bêtông 

 
Start Composite Beam 

Design/Check of Structure 

Thiết kế hoặc kiểm tra cấu kiện dầm 

Composite 

 Steel Joist Design Thiết kế thép (kiến trúc) rầm (nhà) 

 
Start Shear Wall Design/Check of 

Structure 

Thiết kế hoặc kiểm tra cấu kiện vách 

cứng 

 

2.2. Những bƣớc chính khi thực hiện tính kết cấu. 

Sau đây là các bước cơ bản để mô hình hóa, phân tích và thiết kế kết cấu trong Etabs, tuy 

nhiên cũng không cần thiết phải tuân theo chính xác các gợi ý này. 

1. Định đơn vị (lực và chiều dài). Nên chọn đơn vị nào mà sử dụng thường xuyên trong 

quá trình mô hình kết cấu như Ton-m; KN-m…, mặc dù có thể đổi đơn vị sử dụng bất kỳ 

lúc nào ta muốn. 

2. Bắt đầu tạo mô hình, vào File menu > New Model, chọn một trong những phương 

pháp khởi tạo mô hình. 

3. Thiết lập hệ thống lưới(Grid lines). 

4. Định nghĩa các tầng nhà. 

5. Nếu muốn, ta có thể sử dụng những kết cấu mẫu của phần mềm (buit-in Etabs 

templates). 

6. Vào Options menu > Preferences để thay đổi các tùy chọn mặc định (nếu muốn), ví 

dụ kích cỡ chữ, tiêu chuẩn thiết kế sẽ sử dụng,… 

7. Vào Define menu để định nghĩa các đặc trưng cơ học của vật liệu, tiết diện phần tử 

thanh, tường, sàn. 

8. Vào Define menu > Static Load Cases để định nghĩa các trường hợp tải trọng tĩnh. 

Có thể dùng chức năng tự động phát sinh tải trọng do tải gió và động đất. 

9. Nếu có sử dụng khối lượng trong mô hình tính toán (ví dụ để tìm các tần số và dao 

động tự nhiên,…) thì khai báo nguồn tạo ra khối lượng bằng cách vào Define menu > 

Mass Source. 

10. Vẽ các đối tượng Area (mặt), Line (đường) và Point (điểm) bằng cách dùng các biểu 

tượng hoặc vào menu để tạo mô hình. 
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Trong quá trình vẽ các đối tượng hình học, ta nên gán luôn các đặc trưng kết cấu, khối 

lượng và tải trọng cho chúng.  

Lưu ý rằng ta có thể dùng đối tượng Line để làm các đường định vị để bắt điểm, làm 

đường biên khi kéo dài (Extend) hay cắt bớt (Trim) các đối tượng Line khác; hoặc làm các 

đường “nháp” để chia lưới Area (nếu ta chia lưới thủ công). 

Cần quan tâm đến khối lượng (Mass) nếu muốn tìm các dạng dao động tự nhiên (Mode 

shape). 

11. Có thể hiệu chỉnh sơ đồ kết cấu như mong muốn bằng cách dùng lệnh trong Edit 

menu. 

12. Dùng các lệnh trong Assign menu để hiệu chỉnh các đặc trưng của các đối tượng phần 

tử (hình dạng, kích thước tiết diện, khối lượng, tải trọng, giải phóng momen, liên kết nửa 

cứng,…). Cần chọn trước phần tử rồi mới thực hiện các lệnh gán trong Assign menu cho 

các phần tử đã chọn đó. 

13. Xem các thông tin của mô hình kết cấu đã dựng: vào Display menu > Show Loads và 

Display menu > Set Input Table Mode. Ta cũng có thể click chuột phải vào đối tượng 

cần xem thông tin thì màn hình sẽ xuất hiện ra một Form cung cấp các thông tin về đối 

tượng đã chọn. 

Dùng các lệnh trong View menu  Set Building View Options để cho hiện hoặc tắt các 

thông tin nào đó (ví dụ tiết diện, giải phóng momen, khớp dẻo,…) 

14. Vào File menu > Print Tables > Input nếu muốn in thông tin đã nhập cho mô hình ra 

máy in hay lưu thành File. Hoặc dùng File menu > Export > Save Input/Output as 

Access Database File để lưu thông tin thành File cơ sở dữ liệu có thể được xem, hiệu 

chỉnh và in trong phần mềm Microsoft Access. 

15. Xác lập các thông số phân tích (ví dụ, số bậc tự do của mô hình tính toán) trong 

Analyze menu > Set Analysis Options. 

16. Nếu cần chia lưới thủ công cho sàn (Floor), tường/vách (Wall) hoặc mái dốc (Ramp) 

thì vào Edit menu > Mesh Areas. Công việc chia lưới thủ công (Manual meshing) nên 

thực hiện ngay trước khi cho Etabs phân tích kết cấu. 

17. Dùng Analyze menu > Run Analysis để phân tích kết cấu. Khi phân tích xong, nhớ 

kiểm tra xem phần mềm có thông báo lỗi gì hay không. 

18. Hiển thị kết quả phân tích dưới dạng đồ họa hay bảng biểu. 

Nhớ lưu ý một số vấn đề sau: quy ước các thành phần chuyển vị, quy ước về nội lực trong 

phần tử Frame, nội lực trong phần tử Shell, vị trí xuất kết quả và quy ước dấu nội lực cúa 

cột, dầm và vách cứng,… 
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19. Để in kết quả (dưới dạng bảng biểu), vào File menu > Print Tables > Analysis 

Output. Muốn lưu kết quả thành File cơ sở dữ liệu của phần mềm Access thì vào File 

menu > Export > Save Input/Output as Access Database File. 

20. Sử dụng các lệnh trong Design menu để thiết kế kết cấu (có thể phải tính lập vài lần). 

Sau khi chạy xong phần thiết kế,muốn giữ lại kết quả thì Save trước khi thoát ra khỏi 

Etabs. 

2.3. Ví dụ thực hành 

Dựng mô hình và nhập tải trọng cho khung phẳng(thực hành tại lớp). 

 

Sơ đồ phần tử Cột, Dầm khung 
 

Tĩnh tải tác dụng 

 

 

6000 2300

8300

C22x40

C22x40

C22x40

C22x40

C22x40

C22x40 C22x22

C22x22

C22x22

D22x55

D22x55

D22x55 D22x30

D22x30

D22x30 g  =27141
g  =5652

G  =58666 G   =72135* G   =23064*

g  =27141
g  =5652

g    =11981m

2m

3
6

0
0

3
6

0
0

3
6

0
0

6000 2300

8300

G  =58666 G   =72135* G   =23064*

g  =565

G    =2830
6m

G     =42855*m G     =25854*m
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Hoạt tải 1 tác dụng 
 

Hoạt tải 2 tác dụng 

 

 

Gió trái tác dụng 

 

Gió phải tác dụng 

 

Biết rằng đơn vị tính cho lực tập trung là Kg, lực phân bố là Kg/m.Sử dụng bê tông mác 

200.  

 

  

q  =7321I

P  =9726I P   =9725*I

q  =5182I

P   =12345*I P   =12344*I

q     =2751mI

P   =3656I P   =3655*I

3
6

0
0

3
6

0
0

3
6

0
0

6000 2300

8300

P   =2924*I

q  =129
2mII

P  = 309
5*mII
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CHƢƠNG 3. KẾT CẤU HỆ THANH, KẾT CẤU TẤM VỎ. 

 

3.1.Thiết lập mô hình tính toán 

Ở tài liệu này mô hình tính toán công trình dân dụng và công nghiệp chủ yếu sẽ đề cập 

đến cấu hệ thanh (dầm, cột) và kết cấu tấm vỏ (sàn, vách). 

3.1.1.Chọn đơn vi tính toán 

Bước 1: Khởi động phần mềm Etabs 

Bước 2: Click chọn đơn vị là Ton-m ở góc phía dưới bên 

phải của phần mềm 

 

 

3.1.2.Xây dƣng hệ lƣới 

Bước 1: Click vào File chọn biểu tượng New Model ở 

góc phía trên bên trái của phần mềm để tạo file mới  

 

Bước 2: Click vào nút lệnh Default.edb 

 

 

Bước 3 :Trong mục Story Dimensions, nhập các thông số 

về chiều cao các tầng, với các lưu ý: 

-Number of Stories: là số tầng 

-Typical Story Height: là chiều cao tầng điển hình 

-Bottom Story Height: là chiều cao tầng dưới cùng 

-Nếu có nhiều chiều cao tầng, có thể click vào Custom 

Story Data, sau đó click vào Edit Story Data và điều 

chỉnh các chiều cao tầng theo mong muốn. 

 

 

 

Bước 4: Trong mục Grid Dimensions, nhập các thông số 

về hệ lưới, với các lưu ý: 

-Number Lines in X Direction : là số trục theo phương X 

-Number Lines in Y Direction : là số trục theo phương Y 

-Spacing in X Direction : là khoảng các các lưới theo 

phương X 
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-Spacing in Y Direction : là khoảng các các lưới theo 

phương Y 

Bước 5: Click vào tùy chọn Custum Grid Spacing, sau 

đó click vào nút lệnh Grid Labels 

 
 

Bước 6: Đổi giá trị Beginning X ID là 1 và Beginning Y 

ID là A 

Click OK để đóng cửa sổ Grid Labeling Options 

 

Bước 7: Click Edit Grid để thay đổi chi tiết khoảng các 

giữa các trục. 

Click vào tùy chọn Ordinates: Chế độ cộng dồn tọa độ 

Click vào tùy chọn Spacing : Chế độ độc lập các lưới 

Nhập khoảng cách giữa các trục theo phương X (căn cứ 

bản vẽ) vào mục X Grid Data 

Nhập khoảng cách giữa các trục theo phương Y vào mục 

Y Grid Data 

Click OK để đóng cửa sổ Define Gird Data 

Tiếp tục click OK để hoàn thành việc xây dựng hệ lưới 

Nhấn tổ hợp phím Ctrl + S để lưu file 

 

 

 

 

Bước 8: Tùy chỉnh khoảng cách các trục theo bản vẽ 

thiết kế. 

 

3.1.3.Chọn tiêu chuẩn tính toán 

Bước 1: Click vào menu Options > 

Prefrences > Concrete Frame Design  
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Bước 2: Trong mục Design Code, chọn tiêu 

chuẩn là BS8110 97, đổi 2 giá trị cuối cùng của 

bảng thành 1 

 

 

 

Bước 3: Click OK để đóng cửa sổ Concrete Frame Design Prefrences 

3.1.4.Khai báo vật liệu 

Bước 1: Click vào menu Define > Material Properties  

 

Bước 2: Click vào nút lệnh Add New Material 

 

 

 
 

Bước 3: Nhập các thông số như bảng 

dưới dây, với các lưu ý: Mass per unit 

Volumn là khối lượng riêng, Weight per 

unit Volumn là trọng lượng riêng, fcu là 

cường độ tính toán của bê tông, fy là 

cường độ chảy của cốt thép dọc, fys là 

cường độ chảy của cốt đai. Các giá trị đã 

được quy đổi để phù hợp với TCVN.  

 

Bước 4: Click OK để hoàn thành việc tạo vật liệu mới 

Bước 5: Tiếp tục click OK để đóng cửa sổ Define Material 

 

3.1.5.Khai báo tiết diện Dầm, Cột, Sàn, Vách 

Bước 1: Click menu Define > Frame Sections để 

tiến hành khai báo tiết diện Cột, Dầm 
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Bước 2: Giữ phím Shift hoặc Ctrl và click để chọn 

nhiều tên trong danh sách các tiết diện có sẵn của 

Etabs, sau đó click Delete Property để xóa các tiết 

diện này. 

 

Bước 3: Click vào combo thứ 2 bên phải của cửa 

sổ, trong danh sách thả xuống click vào dòng Add 

Rectangular 

 

Nhập các thông số của tiết diện cột vào trong cửa 

sổ khải báo tiết diện. Lưu ý tại ô Material, ta chọn 

vật liệu là B20…, các kích thước Depth là chiều cao 

và Width là chiều rộng của cấu kiện (đơn vị m )  

 

Bước 4: Click OK để đóng cửa sổ Retangular Section 

Bước 5: Tiếp tục click vào combo thứ 2 bên phải của cửa sổ, sau đó click vào dòng Add 

Rectangular trong danh sách thả xuống để thêm tiết diện mới. 

Bước 6: Nếu cấu kiện là dầm: Click vào 

Reinfocement chọn Bean.  

 

 

 

Bước 7: Click vào menu Define > 

Wall/Slab/Deck Sections để tiến hành khai báo 

tiết diện sàn 
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Bước 8: Click Delete Section để xóa bớt các 

loại tiết diện sẽ không dùng đến 

 

 

 

Bước 9: Click hộp combo bên phải cửa sổ, sau 

đó click vào dòng Add New Slab 

Nếu là khai báo vách chọn Add New Wall 

 

 

 

Bước 10: Nhập các thông tin về tiết diện sàn, 

vách vào các ô tương ứng, với lưu ý lựa chọn 

vật liệu (Material). 

Membrane: chiều dày mà Etabs dùng để tính 

toán trọng lượng của sàn. 

Bending: chiều dày mà Etabs dùng để tính toán 

độ cứng của sàn. 

 

Bước 11: Click OK để đóng cửa sổ Wall/Slab 

Section. Tiếp tục click OK để hoàn thành việc 

khai báo tiết diện. 

 
 

3.1.6.Vẽ mô hình 

Etabs cung cấp giao diện đồ họa cho phép người cùng có thể thao tác trực tiếp để vẽ các 

cấu kiện cột, dầm, và sàn. Cũng giống như các công cụ đồ họa khác, chế độ truy bắt điểm 

là chế độ quan trọng không thể thiếu trong Etabs. Các thao tác vẽ chủ yếu sử dụng chế độ 

bắt điểm Snap to Intersections and Points, là chế độ bắt vào các giao điểm của hệ lưới và 

các đối tượng Points trong mô hình. Khi vẽ các dầm phụ hoặc các đối tượng không nằm 

trực tiếp trên hệ lưới, chúng ta cần vẽ thêm các Point để làm căn cứ bắt điểm. Để vẽ các 

Point, chúng ta sử dụng công cụ Draw Point Objects có trong thanh toolbar bên trái của 

Etabs. Nếu Etabs không mặc định sẵn menu Draw hoặc nút lệnh nút lệnh Draw Points 
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trên thanh toolbar phía bên trái, người dùng có thể thực hiện các bước sau để gọi ra. 

Bước 1: Click vào nút lệnh Add or Remove buttons có biểu tượng hình mũi tên quay sang 

trái. 

Bước 2: Click chọn nút lệnh Draw Point Object, 

sau khi thực hiện bước này nút lệnh Draw Point 

Object sẽ xuất hiện ở vị trí thứ 3 từ trên xuống 

trong thanh công cụ bên trái. 
 

 

a)Vẽ điểm 

Bước 1: Click chọn nút lệnh Draw Point Object, sẽ 

xuất hiện cửa sổ Properties of Object. 

-Plant Offset X: Khoảng cách từ điểm gốc đến điểm 

muốn vẽ theo phương X 

-Plant Offset Y: Khoảng cách từ điểm gốc đến điểm 

muốn vẽ theo phương Y 

 

 

Bước 2: Click vào điểm gốc ta được điểm mong 

muốn. 

 

 

b)Vẽ cột 

Bước 1: Click vào thanh tiêu đề của cửa sổ bên trái 

để kích hoạt và thực hiện các hoạt động trên cửa sổ 

bên trái. 

 

Bước 2: Click chọn chế độ All Stories ở ô chọn góc 

phía dưới bên phải của phần mềm. Sau khi chọn 

chế độ này, tất cả các thiết lập trên mặt bằng 

STORY4 sẽ được áp dụng cho toàn bộ các tầng. 

Lưu ý rằng chỉ chọn được chế độ này khi cửa sổ 

mặt bằng đang được chọn. 

 

Bước 3: Click vào nút Create Column in Region or 

at Clicks (Plans) 
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Bước 4 :Đảm bảo bằng cửa sổ Properties of Object 

đang xuất hiện trên màn hình; và ô Property đang 

có giá trị là C30x30. 

Lƣu ý: Nếu là cột hình chữ nhật có thể nhập góc 

xoay của cột vào mục “Angle” 

Bước 5: Lần lượt click vào các điểm lưới để vẽ các 

cột. 

Bước 6: Nhấn Esc trên bàn phím để thoát khỏi chế 

độ vẽ cột. 

 

 

c)Vẽ Dầm 

Bước 1: Click vào nút Draw Line ở 

góc phía trên bên trái vẽ dầm qua 2 

điểm. 

Create Lines in Region vẽ dầm nhanh 

theo hệ lưới.            

Bước 2: Click vào ô Properties trong cửa sổ 

Properties of Object và chọn loại tiết diện. 

Click chuột phải để kết thúc lệch vẽ. 

 

 

 

Vẽ dầm cách dầm một khoảng cho trước. 

Trong cửa sổ Properties of Object nhập khoảng cách 

từ dầm gốc đến dầm muốn vẽ. 

Nhấn Esc để thoát khỏi chế độ vẽ dầm. 

Kết hợp vẽ điểm và vẽ dầm ta sẽ vẽ được mọi dầm 

mong muốn.   
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Bước 3: Click menu View > Set Building View Options.  

Bước 4: Trong mục View by Color of chọn Sections; 

trong mục Special Effects chọn Object Fill; trong mục 

Visible in View bỏ chọn Global Axes; chọn Apply to All 

Windows ở góc phía dưới bên trái. 

 

          

 

 

Click OK để đóng cửa sổ Set Building View Options và quan sát sự thay đổi trên các cửa 

sổ phần mềm. Lúc này các đối tượng đã được phân biệt bởi màu sắc (màu sắc khác nhau 

giữa các loại tiết diện khác nhau). 

d)Vẽ Sàn 

Bước 1: Click vào nút lệnh Draw 

Rectangular Areas để bắt đầu chế độ vẽ Sàn. 

-Draw Areas: Vẽ sàn qua các điểm 

-Create Areas at Click: Vẽ sàn trong giới 

hạn lưới 
        

Bước 2: Hãy chắc chắn rằng cửa sổ 

Properties of Object đang hiển thị, và giá trị 

trong mục Propery là loại sàn muốn chọn 

 

Bước 3: Lần lượt Click vào các điểm biên sàn đi qua. 

Click chuột phải để kết thúc lệch vẽ. 
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Bước 4: Vẽ hết các ô sàn trên mặt bằng với lưu ý trừ ra các phần được ký hiệu là lỗ thủng 

trên mặt bằng kết cấu. 

 

Bước 5: Sử dụng chế độ vẽ điểm (Draw Point Objects) để vẽ các điểm bổ sung và hoàn 

thiện phần sàn công xôn ngoài trục A, trục 1 

Bước 6: Nhấn phím Esc để thoát khỏi chế độ vẽ sàn. 

e)Vẽ các dầm ảo 

Ví dụ: Quan sát trên bản vẽ kiến trúc và kết cấu, ta thấy có 1 vị trí có tường mà không có 

dầm đỡ (hình dưới), chúng ta sẽ tiến hành vẽ các dầm ảo tại vị trí này. 

 

Trong phần sau, chúng ta sẽ tiến hành gán tải trọng lên mô hình, trong đó có tải trọng 
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tường. Thông thường tải trọng tường sẽ được gán lên các dầm đỡ phía dưới tường. Tuy 

nhiên có một số vị trí trên mặt bằng mà ở dưới tường không có dầm đỡ, trong tường hợp 

đó chúng ta sẽ vẽ các dầm ảo ở các vị trí sẽ có tường với mục đích gán tải trọng tường lên 

mô hình. Dầm ảo là các dầm có loại tiết diện là NONE (có sẵn trong Etabs), sẽ không có 

tác dụng phân phối nội lực, chỉ có tác dụng phân phối tải trọng được gán trên nó. Chúng 

ta sẽ vẽ các dầm ảo tương tự cách vẽ dầm thông thường, tuy nhiên có tiết diện là NONE. 

Bước 1: Sử dụng nút lệnh Draw Point Objects để vẽ các điểm bổ sung 

Bước 2: -Click vào nút Draw Line 

- Click chọn loại tiết diện là NONE trong cửa sổ 

Properties of Object 

- Vẽ dầm ảo trên mặt bằng 

- Nhấn Esc để thoát khỏi chế độ vẽ  

 

f)Vẽ vách 

Bước 1: -Click vào nút Draw Walls: Vẽ vách qua các 

điểm. 

-Click vào nút Create Walls in Region or at Click: Vẽ 

vách trên hệ lưới được giới hạn. 
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Bước 2:Trong Properties of Object chọn loại vách vẽ vẽ theo ý muốn. 

 

- Nhấn Esc để thoát khỏi chế độ vẽ. 

Hoàn thiện mô hình: 

Mô hình đã được vẽ ở các bước trên, nhưng chưa thực sự hoàn thiện. Có 2 điểm chưa 

hoàn thiện trong mô hình mà chúng ta có thể nhận ra, đó là: (1) Các tầng kết cấu có thể 

giống hoặc khác nhau, và (2) Chân cột đang được khai báo là khớp, cần phải gán lại là 

ngàm. 

Bước 1: Sao chép các tầng. 

-Khi vẽ xong kết cấu 1 tầng, chọn toàn bộ vùng 

mặt phẳng kết cấu bằng cách giữ chuột trái và 

kéo từ phải qua trái-Từ dưới lên trên. Có thể 

chọn bằng cách ấn tổ hợp phím Ctrl+A hoặc 

chọn biểu tượng “all” trên thanh công cụ. 

-Vào Edit chọn Replicate. 

 

 

 

-Trong Replicate chọn Story. Muốn copy kết 

cấu tầng vừa vẽ giống với tầng nào ta chỉ việc 

giữ chuột trái và chọn vào tầng đó, ấn ok. 

 

 

Bước 2: Gán liên kết ngàm cho chân cột. 

- Di chuyển đến mặt bằng các tầng bằng cách Click 

vào biểu tượng Move Up in List 
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-Mặt bằng đang hiển thị Plan View-BASE 

 

-Chọn toàn bộ các liên kết chân cột. Vào Assign  › 

Joint/Point › Restraints(Supports) 

 

 

 

-Chọn liên kết ngàm. 

 

 

 

       Trong trường hợp khác muốn giải phóng liên kết 

một vị trí nào đó có thể thay đổi những tùy chọn bên 

bằng cách bỏ chọn những nút đánh dấu.  

Một số lƣu ý: 

•  Khi thao tác thực hiện trên một mặt bằng có thể được áp dụng cho toàn bộ các tầng 

thông qua việc lựa chọn chế độ All Story ở góc dưới cùng bên phải của phần mềm. Mỗi 

lần bạn thoát khỏi phần mềm Etabs và mở lại file đã lưu, Etabs sẽ mặc định chế độ One 

Story cho các thao tác trên mặt bằng.  

• Có thể sử dụng nút lệnh Set Plan View để chọn mặt bằng cần quan sát hoặc thao tác 

trên đó. 

3.2. Tính toán và xem kết quả. 

3.2.1. Nhập tải trọng 

Mô hình tính toán công trình dân dụng và công nghiệp bao gồm kết cấu hệ thanh (dầm, 

cột) và kết cấu tấm vỏ (sàn, vách). Phần này đề cập đến các bước thực hành để khai báo 

các trường hợp tải trọng và gán tải trọng vào sơ đồ Etabs trong nhà dân dụng.  

Trước khi tiến hành khai báo các trường hợp tải trọng, chúng ta cần biết có bao nhiêu 

trường hợp tải trọng, gồm những thành phần nào, và được gán vào đâu, thông qua sơ đồ 

phía dưới đây. 

a) Khai báo các trƣờng hợp tải trong 

Bước 1: Click vào menu Define > Static Load Case ...  

Nhập TT trong mục Load, chọn DEAD trong mục Type và nhập 1.1 trong mục Seft-
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Weight Multiplier, sau đó click Add New Load. 

 

 

Bước 2: Xóa các trường hợp tải mặc định bằng cách trong mục Load chọn DEAD, sau đó 

click Delete Load. Tiếp tục trong mục Load chọn LIVE, sau đó click Delete Load 

Bước 3: Khai báo các trường hợp tải còn lại. 

Làm tương tự như Bước 1 ta được kết quả như sau: 

 

Hãy chắc chắn rằng lúc này trong danh sách tải trọng đã có đủ 6 thành phần là TT(Tĩnh 

tải), HT(Hoạt tải), GX(Gió đẩy theo phương X), GXX(Gió hút theo phương X), GY(Gió 

đẩy theo phương Y) và GYY(Gió hút theo phương Y). Click OK để đóng cửa sổ Define 

Static Load. Trường hợp có thêm  tải trọng động đất sẽ được khai báo ở phần sau. 

b) Gán tĩnh tải hoàn thiện sàn 

Tùy theo loại công trình, chúng ta có một vài loại tải trọng hoàn thiện sàn, bao gồm: 
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SÀN LÀM VIỆC, PHÒNG HỌC 

   TT Các lớp vật liệu T.L riêng Chiều dày TTTC Hệ số TTTT 

    Kg/m3 m Kg/m2 vƣợt tải Kg/m2 

1 Gạch lát nền 2200 0.01 22 1.1 24 

2 Vữa lót XM   1800 0.02 36 1.3 47 

3 Vữa trát trần XM  1800 0.015 27 1.3 35 

4 Hệ thống kỹ thuật     20 1.1 22 

  Tổng 1 =   128 

5 Sàn BTCT 2500 0.1 250 1.1 275 

         Tổng tĩnh tải =   403 

       

 

SÀN KHU VỆ SINH  
    

 TT Các lớp vật liệu T.L riêng Chiều dày TTTC Hệ số TTTT 

    Kg/m3 m Kg/m2 vƣợt tải Kg/m2 

1 Gạch lát nền 2200 0.01 22 1.1 24 

2 Vữa lót XM   1800 0.02 36 1.3 47 

3 Vữa trát trần XM  1800 0.015 27 1.3 35 

4 Thiết bị vệ sinh, vách ngăn     110 1.1 121 

5 Tường 110 quy về phân bố     0 1.1 0 

6 Lớp tôn nền 1800 0.05 90 1.3 117 

  Tổng 1 =   344 

7 Sàn BTCT 2500 0.1 250 1.1 275 

         Tổng tĩnh tải =   619 

       SÀN BAN CÔNG,LÔ GIA,CHIẾU NGHỈ  
   

TT Các lớp vật liệu T.L riêng Chiều dày TTTC Hệ số TTTT 

    Kg/m3 m Kg/m2 vƣợt tải Kg/m2 

1 Gạch lát nền 2200 0.01 22 1.1 24 

2 Vữa lót XM   1800 0.02 36 1.3 47 

3 Vữa trát trần XM  1800 0.015 27 1.3 35 

4 Hệ thống kỹ thuật     20 1.1 22 

  Tổng 1 =   128 
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5 Sàn BTCT 2500 0.1 250 1.1 275 

         Tổng tĩnh tải =   403 

       

 

SÀN MÁI 
    

 TT Các lớp vật liệu T.L riêng Chiều dày TTTC Hệ số TTTT 

    Kg/m3 m Kg/m2 vƣợt tải Kg/m2 

1 Lớp XM chống thấm 2500 0.04 100 1.1 110 

2 Vữa trát trần XM  1800 0.015 27 1.3 35 

3 Hệ thống kỹ thuật     20 1.1 22 

  Tổng 1 =   167 

4 Sàn BTCT 2500 0.1 250 1.1 275 

         Tổng tĩnh tải =         442 

       

 

SÀN CẦU THANG d =100. 
    

TT Các lớp vật liệu T.L riêng Chiều dày TTTC Hệ số TTTT 

    Kg/m3 m Kg/m2 vƣợt tải Kg/m2 

1 Gạch lát bậc 2200 0.02 44 1.1 48 

2 Vữa lót XM   1800 0.02 36 1.3 47 

3 Bậc xây gạch 1800 0.075 135 1.3 176 

4 Vữa trát trần XM  1800 0.015 27 1.3 35 

  Tổng 1 =         306 

4 Sàn BTCT dày 100mm 2500 0.1 250 1.1 275 

         Tổng tĩnh tải =         581 

 

Click vào menu Select >by Wall/Slab/Deck Section 
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Chọn SANLV >OK 

( Nếu nhập tải trọng cho nhiều loại sàn 

giống nhau ta có thể giữ chuột trái và bôi 

đen hoặc giữ Ctrl để chọn đồng thời 

nhiều sàn một lúc) 
 

Click vào menu Assign > Shell/Area 

Loads > Uniform 

Mục Load Case Name chọn là TT, nhập 

0.15 vào ô Load, sau đó click OK 

 

 

Tương tự như vậy chọn các sàn còn lại và nhập giá trị ta được kết quả như hình trên. 

c) Gán tải trọng tƣờng. 

Lưu ý rằng đối với từng công trình, chúng ta thường có các loại tường với tải trọng cơ bản 

sau (Đây là ví dụ bảng tính tải trọng một công trình cụ thể): 

TẢI TRỌNG ĐƠN VỊ TƢỜNG 220 - GẠCH ĐẶC 
  

TT Các lớp vật liệu T.L riêng Chiều dày Hệ số 
Tải 

trọng 
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    Kg/m3 m vƣợt tải Kg/m2 

1 Vữa trát XM #75 1800 0.03 1.3 70 

2 Gạch xây  2000 0.22 1.1 484 

  Tổng        554 

  Chiều cao dầm h= 0.35 (m) 

 

  

  Chiều cao tầng h= 3.6 (m) 

 

  

  Chiều cao tường h= 3.25 (m) 

 

  

  Tải trọng tƣờng phân bố trên 1m 
  

1801 

  Nếu kể đến hệ số giảm lỗ cửa 0.75     1351 

TẢI TRỌNG ĐƠN VỊ TƢỜNG 220 - GẠCH ĐẶC 
  

TT Các lớp vật liệu T.L riêng Chiều dày Hệ số 
Tải 

trọng 

    Kg/m3 m vƣợt tải Kg/m2 

1 Vữa trát XM #75 1800 0.03 1.3 70 

2 Gạch xây  2000 0.22 1.1 484 

  Tổng        554 

  Chiều cao dầm h= 0.6 (m) 

 

  

  Chiều cao tầng h= 3.6 (m) 

 

  

  Chiều cao tường h= 3 (m) 

 

  

  Tải trọng tƣờng phân bố trên 1m 
  

1663 

  Nếu kể đến hệ số giảm lỗ cửa 0.75     1247 

 
 

    TẢI TRỌNG ĐƠN VỊ TƢỜNG 110 - GẠCH ĐẶC 
  

TT Các lớp vật liệu T.L riêng Chiều dày Hệ số 
Tải 

trọng 

    Kg/m3 m vƣợt tải Kg/m2 

1 Vữa trát XM #75 1800 0.03 1.3 70 

2 Gạch xây  2000 0.11 1.1 242 

  Tổng        312 

  Chiều cao dầm h= 0.35 (m) 

 

  

  Chiều cao tầng h= 3.6 (m) 

 

  

  Chiều cao tường h= 3.25 (m) 

 

  

  Tải trọng tƣờng phân bố trên 1m 
  

1015 

  Nếu kể đến hệ số giảm lỗ cửa 0.75     761 
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TẢI TRỌNG ĐƠN VỊ TƢỜNG THU HỒI 220 
  

TT Các lớp vật liệu T.L riêng Chiều dày Hệ số 
Tải 

trọng 

    Kg/m3 m vƣợt tải Kg/m2 

1 Vữa trát XM #75 1800 0.03 1.3 70 

2 Gạch xây  2000 0.22 1.1 484 

  Tổng        554 

  Chiều cao tường h= 1 (m) 

 

  

  Tải trọng tƣờng phân bố trên 1m 
  

554 

  Mái tôn+xà gồ 
   

185 

  Tổng       739 

 

Bước 1: Click vào nút lệnh Set Building View 

Options trên thanh công cụ. 

 
 

 

Ẩn sàn và cột bằng cách bỏ chọn các mục Floor 

và Cloumn 

Click OK để đóng cửa sổ Set Building View 

Options 

 

 

 Bước 2: Quan sát trên mặt bằng kiến trúc để chọn các dầm đỡ tường 220 hay tường 110. 

Chọn các dầm đó và nhập tải trọng tương ứng. 
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Ví dụ: Chọn vài dầm như trên hình 

tương ứng với tường phân bố trên 

dầm có tải trọng 1.59T/m. 

Click menu Assign > Frame/Line 

loads > Distributed 

 

 

Mục Load Case Name chọn là TT, 

nhập 1.59 vào ô Load, sau đó 

click OK 
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Để kích hoạt chế độ quan sát giới 

hạn, người dùng sử dụng menu 

View > Set Building View limits, 

giao diện xuất hiện như hình: 

 

 

Click chọn cửa sổ quan sát 

3D: Click vào menu 

Display > Show Loads > 

Frame/Line Chọn Load 

Case là TT, sau đó click 

OK. 

Sau bước này, bạn sẽ thấy 

tải trọng tường đã gán xuất 

hiện trên mô hình 3D 

 

 

d) Gán hoạt tải 

Chúng ta có thể tra hoạt tải trong tiêu chuẩn Việt Nam 2737-1995. 

Một số hoạt tải cơ bản được tổng hợp dưới đây: 

TT Phòng sử dụng 
Hoạt tải 

TC 
Hệ số 

Hoạt tải 

TT 

Hoạt tải 

TT 

    Kg/m2 vƣợt tải Kg/m2 T/m2 

1 Phòng làm việc 200 1.2 240 0.24 
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2 Phòng học 200 1.2 240 0.24 

3 Phòng họp 500 1.2 600 0.6 

4 Sảnh, hành lang, cầu thang 300 1.2 360 0.36 

5 Phòng vệ sinh 150 1.3 195 0.195 

6 Ban công, lô gia 200 1.2 240 0.24 

7 Mái có sử dụng 150 1.2 180 0.18 

8 Mái không sử dụng 75 1.2 90 0.09 

9 Mái tôn ,fibro 30 1.2 36 0.036 

 

Click vào menu Select >by Wall/Slab/Deck Section  

Chọn SANLV >OK 

( Nếu nhập tải trọng cho nhiều loại sàn 

giống nhau ta có thể giữ chuột trái và bôi 

đen hoặc giữ Ctrl để chọn đồng thời 

nhiều sàn một lúc) 
 

 

 

Click vào menu Assign > Shell/Area 

Loads > Uniform 

Mục Load Case Name chọn là HT, nhập 

0.24 vào ô Load, sau đó click OK 
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Tương tự như vậy chọn các sàn còn lại và nhập giá trị ta được kết quả như hình trên. 

 

e) Gán tải trọng ngang thông qua Diaphragm 

Tải trọng ngang như tải trọng gió (thành phần tĩnh và động) và tải trọng động đất có thể 

được gán dưới dạng tải trọng tập trung thông qua Diaphragm. Tải trọng ngang được tính 

toán tác dụng lên mỗi tầng, và được gán lên mức sàn. Khi gán tải trọng ngang thông qua 

Diaphragm, có 2 thông số cần quan tâm, đó là giá trị và vị trí điểm đặt lực trên mặt bằng. 

Để gán tải trọng thông qua Diaphragm, trước hết phải định nghĩa Diaphargm cho 

mô hình, sau đó tiến hành lần lượt theo các bước sau: 

Bước 1: Click vào menu Define > Static Load Cases 

Bước 2: Lần lượt nhập tên tải trọng (Load), kiểu tải trọng (Type) là WIND hoặc QUAKE, 

và quan trọng là trong mục Auto Lateral Load chọn User Defined, sau đó click Add New 

Load 

Bước 3: Nhập giá trị tải trọng theo phương đang xét, và giá trị tọa độ của điểm đặt lực. 

Người dùng có thể nhập từng giá trị hoặc copy-paste giá trị từ file Excel. Tọa độ của điểm 

đặt lực phụ thuộc vào loại tải trọng, đối với tải trọng gió thành phần tĩnh - là tọa độ tâm 

hình học của công trình, đối với tải trọng gió thành phần động hoặc động đất - là tọa độ 

của tâm khối lượng. 
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f) Gán tải trọng gió 

 Có nhiều phương án nhập tải trọng gió như: Nhập gió truyền vào dầm, nhập gió 

vào cột, nhập gió vào tâm hình học(Gió tĩnh), tâm khối lượng(Gió động). Tuy nhiên, các 

cách nhập tải trọng gió vừa nêu sẽ cho kết quả cuối cùng không khác nhau nhiều. Ở tài 

liệu này sẽ hướng dẫn cách nhập gió vào tâm khối lượng là cách nhanh và hiệu quả đối 

với nhà cao tầng. 

-Gán sàn tuyệt đối cứng (Diaphragm): 

Click vào menu Select >  chọn by Area Object 

Type... 

Hộp thoại Select Area Object Type xuất hiện, chọn 

Floor >  OK (Có thể sử dụng cách nhấn tổ hợp 

phím Ctrl+A) 

Click vào menu Assign > Shell/Area >  

Diaphragms... 

Hộp thoại Assign Diaphragms xuất hiện. 

Click chọn D1 >  OK để đóng hộp thoại. 
 

 

-Thực hiện tính toán (lần 1) lấy tọa độ tâm cứng, tâm khối lượng, khối lượng các tầng, 

tần số dao động(nếu tính gió động): 

Click vào menu Analyze > Run Analysis. 

Click vào menu  Display > Show Tables... 

Hộp thoại Choose Tables for Display xuất 

hiện, click chọn Modal Information và 

Building Output. 

 

Khi đó trên màn hình sẽ xuất hiện hộp 

thoại cung cấp cho người sử dụng những 

bảng kết quả của bài toán. 

 

 

 

Click chọn Modal Participating Mass Ratios: 
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Mode: 12 dạng dao động của bài toán. 

Period: chu kỳ (T) ứng với các dạng dao động.  

UX: dịch chuyển theo phương trục X ứng với các dạng dao động (Mode).  

UY: dịch chuyển theo phương trục Y ứng với các dạng dao động (Mode).  

Click chọn Center Mass Rigidity: Bảng  tâm  khối  lượng  tích  lũy  và tâm cứng. 

 

Bảng Center Mass Rigidity. 

− MassX: Khối lượng Diaphram theo phương X. 

− XCM: Tọa độ tâm khối lượng. 

− XCR: Tọa độ tâm cứng. 

Ví dụ: Bảng tính gió tĩnh cho một công trình cụ thể:  

  

BẢNG TÍNH TẢI TRỌNG GIÓ TĨNH 

  Thông số đầu vào 

      Tải trọng gió gán vào dầm biên 

 

W=W0*c*n*k*(hi+hi+1)/2 kN/m 

    Vùng gió B 

      Dạng địa hình II 

      

 

W0= 0.95 kN/m
2
  Áp lực gió theo dạng địa hình 

 

cđ= 0.8 

 

Hệ số khí động 

   

 

ch= 0.6 

      

 

n= 1.2 

 

Hệ số độ tin cậy của tải trọng gió 

 Chiều rộng CT: 

B= 30.22 

      Kết quả 

      
STT Tầng 

Chiều cao Cao độ 
k 

Wđ Wh W W 

m m kN/m kN/m kN/m Tấn 

7 Tầng 7 3.6 25.2 1.18 3.86 2.90 6.76 20.433 

6 Tầng 6 3.6 21.6 1.14 3.76 2.82 6.58 19.8704 

5 Tầng 5 3.6 18 1.11 3.64 2.73 6.38 19.2732 
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4 Tầng 4 3.6 14.4 1.07 3.51 2.64 6.15 18.5856 

3 Tầng 3 3.6 10.8 1.01 3.33 2.49 5.82 17.5855 

2 Tầng 2 3.6 7.2 0.93 3.06 2.30 5.36 16.1964 

1 Tầng 1 3.6 3.6 0.82 2.71 2.03 4.73 14.3073 

Nhập gió vào tâm cứng nhƣ sau: 

Click mở khóa công trình. 

Vào Define > Static Load Cases hộp thoại xuất hiện 

 

 

Click User Defined > Show Lateral Load 

 

Copy tọa độ tâm cứng vào mục X-Ord và Y-Ord 

Copy giá trị gió X ở bảng tính trên vào mục FX 

Tương tự như vậy ta lần lượt nhập được các giá trị gió còn lại. 

g)Tải trọng Động đất 

Người dùng có thể khai báo tải trọng động đất thông qua 2 phương pháp: 

(PP1) Nhập giá trị tải trọng 

(PP2) Nhập phổ phản ứng động đất 

Khi sử dụng (PP1), người dùng cần tính toán tải trọng động đất ứng với mỗi dạng dao 

động (số dạng tuân theo quy định của TCXDVN 375:2006), và nhập tải trọng thông qua 

Diaphragm. Đối với tải trọng động đất, việc khai báo có một số khác biệt so với tải trọng 

gió. 
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Trong phần nhập giá trị, người dùng có thể chỉ định cho phép Etabs tự tính toán và gán vị 

trí điểm đặt lực trùng với tâm khối lượng của mặt bằng bằng cách sử dụng tùy chọn Apply 

at Center of Mass 

 

Khi sử dụng (PP2), người dùng cần tính toán các giá trị của phổ phản ứng theo quy định 

của TCXDVN 375:2006, và lưu vào file TEXT có dạng như hình sau: 

 

Định dạng file chứa giá trị phổ phản ứng dao động 
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Sau khi có file TEXT, người dùng sử dụng 

menu Define > Response Spectrum 

Functions, 

Trong cửa sổ Define Response Spectrum 

Functions, trong mục Choose Function 

Type to Add chọn mục Spectrum from File, 

và click Add New Function 

 

 

Trong cửa sổ Response Spectrum 

Function Definition, chọn Period vs 

Value, click Browse 

 

Trong cửa sổ Pick Function Data File, chọn file type là Text Files (*.txt), sau đó chọn file 

TEXT chứa phổ phản ứng và click Open 

 

 

Trong cửa sổ Response Spectrum Function Definition, click Display Graph để hiển thị 

hình ảnh của phổ, sau đó click Convert to User Defined để chuyển dữ liệu từ file TEXT 

sang file EDB. 
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Ngoài ra, người dùng cũng có thể thiết lập 

để Etabs tự tính toán giá trị của phổ, bằng 

cách chọn EUROCODE8-2004 Spectrum 

trong mục Choose Function Type to Add, 

do TCXDVN 375:2006 được biên dịch từ 

EC8 nên các giá trị của phổ phản ứng do 

Etabs tự tính cũng tương đương với giá trị 

khi tính toán theo TCXDVN 375:2006 
 

 

3.2.2 Thực hiện tính toán và xem kết quả. 

Một vài thao tác quan trọng cần thực hiện đó là: 

a)Chia nhỏ phần tử sàn: Click vào menu Select > chọn by Area Object Type... 

Hộp thoại Select Area Object Type xuất hiện, chọn Floor >  OK(Có thể sử dụng cách 

nhấn tổ hợp phím Ctrl+A) 

Click vào menu Assign >  Shell/Area > Area Object Mesh Options... 

Hộp thoại Area Object Auto Mesh Options xuất hiện. 

Chọn chế độ Auto Mesh Object into Structural Elements >  Chọn Futher Subdivide Auto 

Mesh with Maximum Elemen Size of nhập giá trị là 1. 
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b)Khai báo khối lƣợng tham gia dao động 

-Trong tính toán gió động và động đất cần khai 

báo khối lượng tham gia dao động để tìm chu kỳ 

dao động. 

Vào Define > Mass Source 

Chọn From Loads 

Chọn TT nhập hệ số tổ hợp là 1 

Chọn HT nhập hệ số tổ hợp là 0.5 

  

c)Tổ hợp tải trọng 

Các trường hợp tải trọng: Căn cứ vào kết quả xác định tải trọng gồm tĩnh tải, hoạt tải, 

gió, động đất được xác định từ phần tính tải trọng ta thực hiện khai báo khai báo các 

trường hợp tải trọng sau:  

TT: ( tĩnh tải).  

HT: ( hoạt tải).  

GTXT: (gió tĩnh theo phương X Trái).  

GTXP: (gió tĩnh theo phương X Phải).  

GTYT: (gió tĩnh theo phương Y Trái).  

GTYP: (gió tĩnh theo phương Y Phải).  
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GDX1T, GDX2T….. (gió động theo phương X Trái ở dạng dao động thứ 1,2…i) GDX1P, 

GDX2P….. (gió động theo phương X Phải ở dạng dao động thứ 1,2…i) GDY1T, 

GDY2T….. (gió động theo phương Y Trái ở dạng dao động thứ 1,2…i) GDY1P, 

GDY2P….. (gió động theo phương Y Phải ở dạng dao động thứ 1,2…i) DDX1T, 

DDX2T….. (động đất theo phương X Trái ở dạng dao động thứ 1,2…i) DDX1P, 

DDX2P….. (động đất theo phương X Phải ở dạng dao động thứ 1,2…i) DDY1T, 

DDY2T….. (động đất theo phương Y Trái ở dạng dao động thứ 1,2…i) DDY1P, 

DDY2P….. (động đất theo phương Y Phải ở dạng dao động thứ 1,2…i)  

Gọi: GDXT, GDXP, GDYT, GDYP là tổ hợp gió động theo phương X và Y  

 

Với GXT, GXP, GYT, GYP là tổ hợp tải trọng gió gồm gió tĩnh và gió động theo phương 

X và phương Y ta có:  

 

Gọi: DDXT, DDXP, DDYT, DDYP là tổ hợp động đất theo phương X và Y  

  

Tổ hợp tải trọng: 

-Tổ hợp cơ bản 1: 

TH1 = ADD (1*TT + 1*HT)  

TH2 = ADD (1*TT + 1*GXT)  

TH3 = ADD (1*TT + 1*GXP)  

TH4 = ADD (1*TT + 1*GYT)  

TH5 = ADD (1*TT + 1*GYP)  

-Tổ hợp cơ bản 2  

TH6 = ADD (1*TT + 0,9*HT + 0,9GXT)  

TH7 = ADD (1*TT + 0,9*HT + 0,9GXP)  

TH8 = ADD (1*TT + 0,9*HT + 0,9GYT)  
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TH9 = ADD (1*TT + 0,9*HT + 0,9GYP)  

 -Tổ hợp đặc biệt  

TH10 = ADD [ 0,9*TT + 0,8*HT + DDXT + 0,3 (DDYT hoặc DDYP )]  

TH11 = ADD [ (0,9*TT + 0,8*HT + DDXP + 0,3 (DDYT hoặc DDYP )]  

TH12 = ADD [ (0,9*TT + 0,8*HT + DDYT + 0,3 (DDXT hoặc DDXP )]  

TH13 = ADD [ (0,9*TT + 0,8*HT + DDYP + 0,3 (DDXT hoặc DDXP) ]  

- Tổ hợp bao THBAO = ENVELOP (TH1,TH2,…TH13).  

Ghi chú:  

+ Các hệ số của tổ hợp đặc biệt (TH10,TH11,TH12, TH13) được lấy theo TCXD 198 - 

1997.  

+ Theo tiêu chuẩn thiết kế công trình chịu động đất TCVN 9386:2012 mục 4.3.3.5 có quy 

định đối với tổ hợp động đất như sau:  

EEdx “+” 0,30×EEdy 

0,30× EEdx “+” EEdy 

Trong đó: “+” có nghĩa là “ tổ hợp với ”; EEdx là biểu thị các hệ quả tác động do đặt tác 

động động đất dọc theo trục nằm ngang X được chọn của kết cấu; EEdy là biểu thị các hệ 

quả tác động do đặt tác động động đất dọc theo trục nằm ngang Y vuông góc của kết cấu 

Hệ số cho một số tổ hợp cơ bản (THCB) và tổ hợp đặc biệt (THĐB) theo Tiêu chuẩn 

TCVN 2737-95 . 

Etabs cung cấp 4 kiểu tổ hợp tải trọng, trong đó có 3 loại được sử dụng phổ biến 

là: 

• ADD: Tổ hợp cộng, giá trị tổ hợp bằng tổng của các trường hợp thành phần 

• ENVE: Tổ hợp bao, giá trị tổ hợp bằng giá trị cực trị của các trường hợp thành 

phần, thể hiện dưới 2 giá trị MAX và MIN 

• SRSS: Tổ hợp trung bình phương, giá trị tổ hợp bằng căn của tổng các bình 

phương của các trường hợp thành phần, thể hiện dưới 2 giá trị MAX và MIN 

Ví dụ khai báo tổ hợp tải trọng cho công trình chỉ có gió tĩnh: 

Vào Define > Load Combinations > Add New Combinations 
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Nhập lần lượt các trường hợp tổ hợp TH1-TH9 tương ứng COMB1- COMB9. Lưu ý rằng 

trong mục Load Combinations Type chọn Add. Trường hợp tổ hợp BAO trong mục Load 

Combinations Type chọn Enve. 

c)Kiểm tra, chạy mô hình và xuất kết quả. 

-Vào Analyze > Set Analysis Options để xác lập các 

thông số phân tích (ví dụ, số bậc tự do của mô hình 

tính toán) 

-Vào Analyze > Check Model để kiểm tra lỗi mô 

hình. Chọn tích vào tất cả các dòng trong hộp thoại 

Check Model và nhấn OK, nếu hiển thị dòng chữ 

“Model has been checked, No warning messages” 

tức là không có lỗi. Ngược lại nếu hiển thị lỗi ở đâu 

dòng nhắc sẽ báo, tùy trường hợp cụ thể ta có thể 

sửa lỗi cho mô hình. 

 

 

 

-Vào  Analyze menu > Run Analysis để phân tích kết cấu(có thể nhấn F5). Khi lưu file cần 

đặt tên file “Không dấu” và trong đường dẫn có tên thư mục “Không dấu”. 

-Để in kết quả (dưới dạng bảng biểu), vào File > Print Tables > Analysis Output. Muốn 

lưu kết quả thành File cơ sở dữ liệu của phần mềm Access thì vào File > Export > Save 

Input/Output as Access Database File. 
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-Xuất kết quả dưới dạng hình ảnh và bảng biểu: 

+Vào Display >Show Member Forces/Stress 

Diagram >Frame/Pier/Spandrel Forces 

Để xem kết quả nội lực dưới dạng hình ảnh. 

+Vào Display >Show Model Shape Để đọc 

và xem biên độ dao động. 

+Vào Display > Show Deformed 

Để xem biến dạng. 

 

 

Ví dụ: Vào Display >Show Member Forces/Stress Diagram 

>Frame/Pier/Spandrel Forces 

Để xem kết quả nội lực dưới dạng hình ảnh: 

 Trong mục Load chọn trường hợp tải muốn xem. 

 Trong mục Component muốn xem hình ảnh nào thì tích chọn 

vào dòng đó: 

Axial: Lực dọc  

Shear 2-2: Lực cắt 2-2 

Moment 3-3: Mômen 3-3 

 Trong mục Scaling chọn tỷ lệ hình ảnh: 

Auto: Chế độ tự động (thường chọn) 

Scale Factor: Nhập tỷ lệ muốn có 

 Trong mục Option: 

Fill Diagram: Chế độ lấp đầy(thường bỏ chọn) 

Show values on Diagram: Xem hình và giá trị(thường chọn) 

 

 

Chế độ lấp đầy Xem hình và giá trị 

  

 

-Xuất kết quả dưới dạng Excel: 

+Vào Display > Show tables. Khi hộp thoại Choose Tables for Display xuất hiện. 
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+Click chọn Modal Information để xuất tần số dao 

động. 

+Click chọn Building Output để xuất tọa độ tâm cứng, 

tâm khối lượng, khối lượng các tầng. 

+Click chọn Frame Output để xuất nội lực hệ thanh 

(nội lực dầm cột) 

+Click chọn Area Output để xuất nội lực sàn. 

Nhấn OK khi đã chọn những giá trị mong muốn. 

 

 

+ Click biểu tượng nút sổ chọn Beam Forces để lựa chọn giá trị nội lực toàn bộ dầm 

muốn xuất. 

+ Trong mục Beam Forces chọn Edit > Copy Entire Table . 

+ Mở một bảng Excel bất kỳ và Paste vào đó. 

 

Làm tương tự với Column Forces (nội lực cột) và các thành phần khác. 

 

3.2.3.Tính cốt thép theo TCVN. 

1. Chọn tiêu chuẩn thiết kế Bê tông cốt thép: 

        Do Etabs không có 

TCVN, nên dùng tiêu 

chuẩn gần giống nhất là 

Tiêu chuẩn Canada. 

Vào Menu Options  

Preferences  Concrete 

Frame Design đổi Design 

Code thành CSA-A23.3.94 

  

  



 

53 

 

2. Khai báo cƣờng độ vật liệu bê tông và thép: 

Vào Menu Define  Materials Chọn CONC  Modify/Show Materrial... 

 Nhập giá trị cường độ bê tông f'c theo bảng 1 tùy thuộc mác bê tông, giá trị fy theo 

bảng 2 tùy thuộc loại thép. Ví dụ dùng bê tông M.250
#
 thì nhập f'c = 224.4 kG/cm

2
 = 2244 

T/m
2
, cốt thép loại AII thì nhập fy = fys = 3176.47 kG/cm

2
 = 31764.7 T/m

2
. 

 

  Bảng 1 : Giá trị 'cf  tương ứng với mác bê tông theo TCVN 

Mác Bê tông 150 200 250 300 350 400 500 600 

Rn (kG/cm
2
) 65 90 110 130 155 170 215 250 

f'c (kG/cm
2
) 130.39 182.22 224.40 267.26 321.85 355.16 457.85 540.81 

  Bảng 2 : Giá trị yf  tương ứng với loại cốt thép theo TCVN 

Loại thép AI AII AIII CI CII CIII 

Ra 

(kG/cm
2
) 

2100 2700 3600 2000 2600 3400 

fy (kG/cm
2
) 2470.59 3176.47 4235.29 2352.94 3058.82 4000.00 

3. Khai báo cách bố trí cốt thép trong tiết diện: 

Nguyên tắc chung:  - Dầm tính theo cấu kiện chịu uốn 

   - Cột tính theo cấu kiện chịu nén lệch tâm xiên (chịu lực dọc và 

moment uốn theo cả 2 phương), do tính chất của bài toán tính thép cột khác với dầm nên 

đối với tiết diện cột cần phải khai báo số lượng các thanh thép trên mỗi biên của cột. 
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Dù Dầm và Cột cùng 1 kích thước tiết diện vẫn phải khai báo là 2 loại tiết diện riêng biệt. 

Ví dụ trong khung: cột có kích thước 200x300, dầm cũng có kích thước 200x300 thì phải 

khai báo 2 loại tiết diện COT20x30 và DAM20x30 để gán cho thanh cột và thanh dầm. 

Vào Menu Define  Frame Sections  Chọn Add Rectangular nếu muốn khai báo tiết 

diện mới hoặc chọn loại tiết diện đã khai báo rồi chọn Modify/Show Property để sửa. 

a.Đối với Dầm: 

 

 b.Đối với Cột: 

 

 

 

 

 

 

 

 

 

 

 

- Chọn Design Type là Beam 

- Khai báo khoảng cách từ mép tiết 

diện đến trọng tâm cốt thép của cốt 

thép trên và cốt thép dưới. 

Như trên là khai báo khoảng cách 

đó là 4cm = 0,04m 

Loại tiết diện Cột hay Dầm 

Khoảng cách từ 

mép bê tông đến 

trọng tâm cốt thép 
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Chọn loại tiết diện là Column (Cột) 

Cốt thép bố trí trong cột 

theo hình chữ nhật                 hay hình tròn 

 

Kiểu cốt đai là đai thường hay đai xoắn (spiral) 

 

Khoảng cách từ mép BT đến trọng tâm cốt thép 

 

Số thanh theo phương chiều cao của tiết diện cột 

 

Số thanh theo phương bề rộng của tiết diện cột 

 

3-dir = 3 

2-dir = 2 

 

3-dir = 2 

2-dir = 3 

 Sau này nên chú  ý các chấm đ̉ trên hình vẽ tiết

diện để kiểm tra 

 
Chọn kiểu bài toán là thiết kế. 
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4. Khai báo tổ hợp nội lực sử dụng để tính cốt thép: 

Chọn tổ hợp để tính cốt thép khung, có thể dùng tổ hợp BAO để tính cốt thép (lúc đó nội 

lực tính toán sẽ là Mmax - Nmax  cốt thép) hoặc liệt kê các tổ hợp có thể có (lúc đó cốt 

thép sẽ được tính toán với tất cả các tổ hợp và lấy kết quả cốt thép lớn nhất). Có thể Etabs 

tự tổ hợp theo tiêu chuẩn của nó, do đó ta cần bỏ (remove) các tổ hợp mà Etabs tự tạo. 

Vào menu Design  Concrete Frame Design  Select Design Combo  

  

 

5. Khai báo hệ số điều chỉnh: 

Do dùng tiêu chuẩn Canada nên cần phải điều chỉnh để phù hợp với tiêu chuẩn Việt nam. 

Ở đây chỉ cần điều chỉnh trong các thanh cột, còn cốt thép dầm tính theo tiêu chuẩn 

Canada hoàn toàn khớp với tiêu chuẩn Việt nam. 

Chọn tất cả các tiết diện cột bằng cách vào Select > by Frame sections> COT, sau đó vào 

menu Design  Concrete Frame Design  View/Revise Overwrite  

Nhập K = 0,69 (cho cả 2 phương Major và Minor) 

 

Các tổ hợp 

DCON1,2 là 

do Etabs tự 
tổ hợp, chọn 

các tổ hợp đó 

và bấm 

Remove 

Chọn tổ 

hợp BAO 

và bấm 

Add 
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Nhớ sau khi nhập lệnh xong thì cần hủy chọn các thanh cột ( bấm nút  ). 

6. Tính nội lực và tính cốt thép: 

Tính nội lực như bình thường, chọn   Run Now. 

Sau khi có nội lực tính cốt thép, vào Menu Design  Concrete Frame Design  Start 

Design/Check of Structure. Trên màn hình sẽ hiển thị diện tích cốt dọc trong hệ. 

- Đối với dầm: sẽ thể hiện cốt thép trên và dưới 

- Đối với cột sẽ thể hiện T NG lượng thép, căn cứ vào số thanh thép đã khai báo ở phần 

Frame Section mà chọn   cho phù hợp yêu cầu. 

Sau này bất cứ lúc nào ta cũng có thể xem lại được diện tích cốt thép bằng lệnh: Vào 

Menu Design  Concrete Frame Design  Display Design Info. 

Chú ý nên đổi sang đơn vị Ton-cm để cốt thép thể hiện cho dễ đọc. 

 

* Ch   :  ệ số điều ch nh K   0,     trên là hệ số trung bình, nếu tính chính xác thì sau 

khi tính được cốt th p  a trong cột thì tính lại hàm lượng và điều ch nh lại hệ số K như 

bảng sau (việc làm này khá mất thời gian do m i cột có m i   khác nhau nên sẽ có m i K 

khác nhau, do đó phải nhập K cho từng thanh cột)  

  Bảng 3 : Giá trị K tương ứng với mác bê tông và hàm lượng cốt thép 

 

Mác bê tông 

 

 

Hàm lượng  

150 200 250 300 350 400 500 600 

Diện tích Fa ở dưới 

tại gối - nhịp - gối 

Diện tích Fa ở trên 

tại gối - nhịp - gối 

Tổng 

diện tích 

Fa trong 

cột 
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1.0% 0.73 0.75 0.77 0.79 0.80 0.81 0.82 0.83 

1.5% 0.64 0.67 0.69 0.71 0.72 0.73 0.75 0.76 

2.0% 0.58 0.61 0.63 0.65 0.66 0.68 0.69 0.71 

2.5% 0.54 0.56 0.59 0.60 0.62 0.63 0.65 0.66 

3.0% 0.50 0.53 0.55 0.57 0.58 0.59 0.61 0.62 

3.5% 0.47 0.50 0.52 0.53 0.55 0.56 0.58 0.59 

4.0% 0.45 0.47 0.49 0.51 0.52 0.53 0.55 0.56 

4.5% 0.43 0.45 0.47 0.49 0.50 0.51 0.53 0.54 

5.0% 0.41 0.43 0.46 0.47 0.48 0.49 0.51 0.52 

5.5% 0.39 0.41 0.43 0.45 0.46 0.47 0.49 0.50 

6.0% 0.38 0.40 0.42 0.43 0.44 0.46 0.47 0.48 

 

3.3. Một số kiến thức Etabs nâng cao . 

3.3.1.Báo lỗi và khắc phục. 

a)Lỗi Xây dựng mô hình. 

Khi kiểm tra mô hình, người dùng sử dụng menu Analyze > Check Model 

-Trong hình bên, có thể thấy một số lỗi 

phổ biến thường gặp, đó là các cấu kiện 

bị chồng lên nhau (overlap), và lỗi 

phân phối tải trọng sàn (area load 

transfer error). 

-Có thể khắc phục các lỗi bằng cách xử 

lý trực tiếp các lỗi hiển thị ở dòng nhắc.  

b)Lỗi khi khai báo Diaphragm 

 Sau khi hoàn thiện mô hình bao gồm việc 

khai báo Diaphragm, và tiến hành phân 

tích kết cấu (Analyze), Etabs sẽ hiển thị 

một thông báo lỗi thường hay gặp trong 

việc khai báo Diaphragm như hình bên. 
 

Ý nghĩa của thông báo là trong Diaphragm có những điểm không cùng cao độ với các 

điểm khác.  

Cần thống nhất quan điểm về Diaphragm trước khi tìm cách khắc phục lỗi này: 

-Việc gán Diaphragm (rigid diaphragm) là để sử dụng giả thiết sàn tuyệt đối cứng, các 

điểm trong cùng 1 Diaphragm sẽ có cùng một chuyển vị ngang. 
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-Dù công trình được đặt chung 1 Diaphragm, nhưng phạm vi áp dụng cho Diaphragm là 

cho từng tầng. Các điểm ở trong cùng 1 Diaphargm nhưng ở 2 tầng khác nhau thì có thể 

có chuyển vị ngang khác nhau. 

Có 2 nhóm phần tử trong Diaphragm. Nhóm thứ nhất là Points, nhóm thứ hai là Shell. Do 

đó có thể gán Diaphragm bằng 2 cách, đó là: (1) chọn các điểm và click Assign > 

Joint/Point > Diaphragms' (2) chọn các tấm sàn và click Assign > Shell/Area > 

Diaphragms. 

Như đã đề cập ở trên, khi trong 1 tầng, có các điểm ở cao độ trung gian của tầng cũng 

được gán vào Diaphragm thì Etabs sẽ báo lỗi như hình trên. Như vậy, để khắc phục thông 

báo lỗi ở trên, người dùng có thể thực hiện bằng cách loại bỏ các điểm trung gian giữa các 

tầng ra khỏi Diaphragm. Thông qua hai bước: 

Bước 1: Loại bỏ các phần tử Ramp ra khỏi 

Diaphragm. Chọn rất cả các Ramp bằng cách click 

menu Select > by Area Object Type, trong cửa sổ 

Select Area Object Type, chọn Ramp và click OK 

 

Tiếp tục click menu Assign > Shell/Area > Diaphragms (nếu không có phần tử Ramp nào 

trong mô hình thì menu này ở chế độ ẩn, không cần thực hiện tiếp bước này mà chuyển 

sang bước 2), trong cửa sổ Assign Diaphragm, chọn NONE và click OK. 

Bước 2: Loại bỏ các Point ra khỏi Diaphragm. 

Chọn toàn bộ mô hình bằng cách sử dụng tổ hợp 

phím Ctrl+A, sau đó click menu Assign > 

Joint/Point, trong cửa sổ Assign Diaphragm, chọn 

NONE và click OK 

 

Bước 2 sẽ loại bỏ tất cả các point không đi kèm với phần từ Shell ra khỏi Diaphragm. 

Sau khi thực hiện 2 bước trên, nếu khi phân tích mô hình mà Etabs vẫn hiện thông báo lỗi 

thì nhiều khả năng trong mô hình đã có những phần tử Shell nằm ngang (không phải 

Ramp) ở cao độ trung gian giữa các tầng. Trong trường hợp đó, cần tìm ra được các phần 

tử này và thực hiện các bước tương tự như trên để gỡ bỏ chúng ra khỏi Diaphragm. 
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3.3.2.Thiết kế cốt thép. 

a)Tính toán và kiểm tra. 

Đối với các cấu kiện cột và vách, Etabs cho phép người dùng thực hiện một trong hai quy 

trình là tính toán hoặc kiểm tra (Design / Check). 

Nếu người dùng chọn quy trình tính toán (design), Etabs sẽ thực hiện tính toán diện tích 

cốt thép của cấu kiện dựa trên nội lực phân tích được và thông số về vật liệu mà người 

dùng khai báo. 

Nếu người dùng chọn quy trình kiểm tra (check), Etabs sẽ thực hiện kiểm tra khả năng 

chịu lực của cấu kiện dựa trên nội lực phân tích được, thông số về vật liệu, và bố trí cốt 

thép mà người dùng đã khai báo. 

-Đối với cột, người dùng lựa 

chọn một trong hai quy trình này 

ngay trong phần khai báo đặc 

trưng tiết diện. Trong cửa sổ 

Rectangule Section, click 

Reinforcement 

 

 

Trong cửa sổ Reinforcement Data, 

tại mục Check/Design người dùng 

chọn quy trình tương ứng. 
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-Đối với vách, để chọn một trong hai quy trình trên, 

người dùng tiến hành chọn vách, sau đó click menu 

Design > Shear Wall Design > Assign Pier Section 

for Checking > General Reinforcing Pier Section. 

Trong cửa sổ Assign General Reinforcing Pier 

Sections, tại mục Check/Design người dùng có thể 

chọn quy trình tương ứng. 

 

 

Trong thực hành, thông thường chọn quy trình toán toán đối với cột, và quy trình kiểm tra 

đối với vách.  

Quá trình tính toán hoặc kiểm tra cốt thép cột được thực hiện bằng cách click menu 

Design > Concrete Frame Design > Start Design/Check of Structure. 

Quá trình tính toán hoặc kiểm tra cốt thép vách được thực hiện bằng cách click menu 

Design > Shear Wall Design > Start Design/Check of Structure. 

b)Ý nghĩa giá trị diện tích cốt thép cột nhƣ thế nào. 

Etabs tính toán diện tích cốt thép cột thông qua phương pháp lập biểu đồ tương tác. Giá trí 

diện tích cốt thép cột được hiển thị (kết quả design) là giá trị diện tích cốt thép lớn nhất 

trong các trường hợp tổ hợp trên cả 3 tiết diện của cột (chân cột, giữa cột, đỉnh cột). 

Giá trị diện tích cốt thép cột được hiển thị (kết quả design - từ đây gọi tắt là diện tích thép 

yêu cầu hoặc diện tích thép) là tổng diện tích cốt thép trên toàn bộ tiết diện. 

Quy trình tính toán diện tích cốt thép cột đi theo các bước cơ bản như sau: 

- Bố trí sẵn vị trí cốt thép. 

- Cho hàm lượng cốt thép thay đổi, tính toán giá trị của biểu đồ tương tác, kiểm tra khả 

năng chịu lực (điều kiện đảm bảo khả năng chịu lực là hệ số an toàn SF > 1) 

- Bằng phương pháp đúng dần, tìm hàm lượng cốt thép thỏa mãn SF lớn hơn và gần bằng 

1 (hàm lượng cốt thép tối thiểu đảm bảo khả năng chịu lực) 

Như vậy, diện tích cốt thép tính toán được trong Etabs, về nguyên lý, phụ thuộc vào việc 

bố trí sẵn vị trí cốt thép. Việc bố trí cốt thép khác nhau sẽ đưa đến các kết quả về diện tích 

cốt thép khác nhau, sai số phụ thuộc vào cách thức bố trí và giá trị nội lực. Người dùng có 

thể khai báo vị trí (kiểu bố trí) cốt thép ngay khi khai báo tiết diện cột. Bằng cách khai 

báo cốt thép tập trung trên một cạnh hay phân bố đều trên tiết diện, người dùng đã chủ 

động chọn lựa việc cột chủ yếu làm việc một phương hay làm việc theo hai phương. 
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c)Diện tích cốt thép đai. 

-Sau khi tiến hành thiết kế (Design), 

người dùng có thể đọc kết quả tính toán 

diện tích cốt thép đai bằng cách click 

menu Design > Concrete Frame Design 

> Display Design Info. Trong cửa sổ 

Display Design Results, tại mục Design 

Output, chọn Shear Reinforcing 
 

Người dùng cũng có thể đọc kết quả cho 

mỗi cấu kiện bằng cách click chuột phải 

vào cấu kiện đó, kết quả sẽ được thể hiện 

như hình bên. 

 

Giá trị cốt thép chịu cắt được lấy bằng Asv/Sv, trong đó Asv là diện tích cốt đai và Sv là 

khoảng cách giữa các cốt đai. 

Với ví dụ trong hình hên, đơn vị là cm, nếu khoảng cách cốt đai là 15cm, thì diện tích cốt 

đai yêu cầu là: Asv = 0.058 * 15 = 0.87 cm
2
. Nếu sử dụng đai 2 nhánh, diện tích yêu cầu 

của mỗi nhánh sẽ là: Asv1 = Asv/2 = 0.435 cm
2
. Như vậy, nếu bố trí đai 2 nhánh, với ví dụ 

trên đây, chúng ta phải bố trí cốt đai là 08@150. 

d)Bổ sung loại đƣờng kính cốt thép. 

Chúng ta cần quan tâm đến loại đường kính cốt thép trong Etabs khi cần kiểm tra khả 

năng chịu lực của các cấu kiện, thông thường là đối với Vách. Etabs đã mặc định một số 

loại đường kính cốt thép theo các tiêu chuẩn, nhưng thiếu đi một số loại đường kính 

thường dùng trong tiêu chuẩn Việt Nam như D18, D22, D32. Chính vì thế, người dùng 

cần chủ động bổ sung các loại đường kính này trong Etabs. 
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- Để bổ sung các loại đường kính trong 

Etabs, bạn click menu Options > 

Preferences > Reinforcements Bar 

Size, cửa sổ Reinforing Bar Sizes xuất 

hiện cho phép bạn thêm các đường 

kính thép. 

Lưu ý rằng chỉ nên thêm các đường 

kính chứ không nên xóa các đường 

kính trong danh sách sẵn có vì có thể 

sẽ gây lỗi cho Etabs. 

 

e)Ý nghĩa O/S trong Etabs khi thiết kế cốt thép. 

Ký hiệu O/S là viết tắt của cụm từ Over Strength, thông báo rằng cấu kiện không đảm bảo 

khả năng chịu lực, xảy ra khi hàm lượng cốt thép tính toán vượt quá hàm lượng tối đa cho 

phép. Trong trường hợp này, đòi hỏi phải có giải pháp khắc phục, có thể là: 

-Thay đổi kích thước tiết diện 

-Thay đổi cường độ vật liệu (tăng cấp độ bền bê tông, sử dụng nhóm thép cao hơn, sử 

dụng biện pháp gia cố ...) 

-Thay đổi phương án kết cấu để điều chỉnh nội lực phân phối lên cấu kiện đang xét 

f)Làm tròn kết quả tính toán. 

- Hình thức hiển thị kết quả liên quan đến chức năng 

thể hiện của Etabs, được điều chỉnh thông qua menu 

Options của Etabs, trong trường hợp này là Options 

> Preferences > Output Decimals. Cửa sổ Output 

Decimals Preferences xuất hiện cho phép điều chỉnh 

số chữ số dấu phẩy (mức độ làm tròn) trong kết quả 

các kết quả tính toán. Để điều chỉnh mức độ làm tròn 

kết quả cốt thép, bạn điều chỉnh thông số Rebar 

Areas, ví dụ muốn kết quả chỉ có 1 con số sau dấu 

phẩy, bạn đặt là 1. 

Chuyển đơn vị sang Ton-cm nếu diện tích cốt thép 

nhỏ. 

 

g)Ý nghĩa của hê số Pattern Live Load Factor 

Để kể đến tác động bất lợi của sự xuất hiện không đồng thời của hoạt tải, Etabs bổ 

sung hệ số Pattern Live Load Factor (PLLF) cho phép người dùng tác động đến việc 
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phân phối lại mô men đối với hoạt tải theo hệ số giả thiết. 

Người dùng thay đổi hệ số này bằng cách click menu: Options > Preferences > 

Concrete Frame Design (đối với kết cấu bê tông cốt thép). 

Giá trị mặc định trong Etabs là 

0.75; hệ số này chỉ ảnh hưởng 

đến nội lực trong quá trình tự 

động thiết kế cốt thép chứ không 

ảnh hưởng đến nội lực của kết 

quả phân tích kết cấu, do đó 

nhiều người sẽ thắc mắc tại sao 

hai giá trị mô men này lại khác 

nhau trong Etabs. 

 

Khái niệm này thực ra rất gần gũi với sinh viên Việt Nam thông qua tên gọi: chất hoạt tải 

lệch tầng lệch nhịp, đó là để kể đến tác dụng bất lợi của phần nội lực sinh ra trên một nhịp 

khi hoạt tải xuất hiện trên nhịp liền kề. 

Tuy nhiên việc áp dụng trong phần mềm không đơn giản như tính toán trong thực tế, do 

đó Etabs dùng một hệ số gần đúng chính là PLLF. 

Nếu hệ số PLLF = 0, Etabs sẽ thiết kế cốt thép mà không kể đến ảnh hưởng của khả năng 

chất tải lệch tầng lệch nhịp. 

Nếu hệ số PLLF <;> 0, mô men dương trong dầm sẽ được tính toán bằng (mô men do tĩnh 

tải) + PLLF * (mô men do hoạt tải với giả thiết dầm có 2 đầu liên kết khớp. 

3.3.3.Chuyển chế độ hiển thị sang Style đen trắng. 

-Khi muốn trích xuất hình ảnh để 

chèn vào các bảng tính, người 

dùng có thể chuyển chế độ hiển 

thị của Etabs sang nền màu trắng, 

và mô hình màu xám để có được 

hình ảnh dễ nhìn hơn. 
 

Để thực hiện điều này, click menu Options > Color > Set Active Theme 
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Trong cửa sổ Display Theme, chọn 

Gray-Scale 

 

Phía dưới là hình ảnh cửa sổ làm việc của Etabs sau khi đã đổi style 

Trong trường hợp muốn đổi 

lại nền mặc định, người 

dùng tiến hành lần lượt các 

bước trên và đặt lại chế độ 

Classical trong cửa số 

Display Theme. 

 

 

-Khi muốn hiển thị cả giá trị và hình 

ảnh biểu đồ sắc nét dạng đen trắng 

người dung vào Options> Colors> 

Ouput 

 

Trong mục Diagram Fill chọn chuyển 

các mục sang màu đen. 
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Trong mục 

Diagram Fill chọn 

chuyển các mục 

sang màu đen.  

3.3.4.Xây dựng nhiều hệ tọa độ trong một hệ kết cấu. 

Thực hiện trực tiếp trên tiết giảng thông qua ví dụ: 

 

 

3.3.4.Bài tập thực hành. 

Thực hành trực tiếp trên máy dựng mô hình của các công trình sau. 

 



 

67 

 

 



 

68 

 

 



 

69 

 



 

70 

 

CHƢƠNG 4. BÀI TOÁN THIẾT KẾ NHÀ DÂN DỤNG. 

 

4.1.Các bƣớc thực hiện thiết kế nhà dân dụng. 

1.Xây dựng hệ lƣới. 

- Định đơn vị (lực và chiều dài). Nên chọn đơn vị nào mà sử dụng thường xuyên trong 

quá trình mô hình kết cấu như Ton-m; KN-m…, mặc dù có thể đổi đơn vị sử dụng bất kỳ 

lúc nào ta muốn. 

- Bắt đầu tạo mô hình, vào File menu > New Model, chọn một trong những phương pháp 

khởi tạo mô hình. 

- Thiết lập hệ thống lưới(Grid lines). Hệ lưới này căn cứ chủ yếu vào bản vẽ kiến trúc của 

công trình(số trục theo 2 phương, số tầng, chiều cao…) 

2.Khai báo đặc trƣng vật liệu và tiết diện của phần tử. 

- Vào Define>Material Properties để định nghĩa các đặc trưng cơ học của vật liệu. Một 

vài đặc trưng của vật liệu như: 

Mass per unit Volumn: là khối lượng riêng 

Weight per unit Volumn: là trọng lượng riêng 

Modulus of Elasticity: là mô đun đàn hồi 

fcu : là cường độ tính toán của bê tông = fc 

fy : là cường độ chịu kéo của thép, tính theo giới hạn chảy. Ví dụ AII có Ratt=2800 

kg/cm1, nhưng fy=3000 kg/cm2. 

fys : là cường độ chịu cắt của cốt thép, tính theo giới hạn chảy ví dụ: AI có fys =2100 

- Vào Define>Frame sections/ Wall/Slab/Deck sections để định nghĩa tiết diện phần tử 

thanh, vách, sàn. 

Beam: 

+Top =a’ (chiều dày lớp bảo vệ phía trên ) 

+Bottom =a (chiều dày lớp bảo vệ phía dưới ) 

+Reinforcement Overrides for Ductile Beams : chiều dài đoạn cốt thép chồng nhau 

Column: 

Rectangular Reiforcement: 

+Cover to rebar Center =a (chiều dày lớp bảo vệ tính đến tâm cốt thép) 

+Number bar in dir 3: Số lớp cốt thép tính theo phương 3 

+Number bar in dir 2: Số lớp cốt thép tính theo phương 2. 

+Bar size : chọn diện tích thanh thép 
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+Check/Design : Chọn một trong hai kiểu Design or Area of one bar: 

+Reiforcement to be Designed: bài toán thiết kế 

+Reiforcement to be checked : bài toán kiểm tra 

- Vào Select menu và Assign menu để hiệu chỉnh các tiết diện nếu muốn. 

3.Vẽ và hiệu chỉnh mô hình. 

- Vẽ các đối tượng Area (mặt), Line (đường) và Point (điểm) bằng cách dùng các biểu 

tượng hoặc vào menu để tạo mô hình. 

- Có thể hiệu chỉnh sơ đồ kết cấu như mong muốn bằng cách dùng lệnh trong Edit menu. 

- Dùng các lệnh trong Assign menu để hiệu chỉnh các đặc trưng của các đối tượng phần tử 

(hình dạng, kích thước tiết diện, khối lượng, tải trọng, giải phóng momen, liên kết nửa 

cứng,…). Cần chọn trước phần tử rồi mới thực hiện các lệnh gán trong Assign menu cho 

các phần tử đã chọn đó. 

- Dùng các lệnh trong View menu  Set Building View Options để cho hiện hoặc tắt các 

thông tin nào đó (ví dụ tiết diện, giải phóng momen, khớp dẻo,…) 

- Vào Options menu > Preferences để thay đổi các tùy chọn mặc định (nếu muốn), ví dụ 

kích cỡ chữ, tiêu chuẩn thiết kế sẽ sử dụng,… 

4.Khai báo tải trọng và tổ hợp tải trọng. 

- Vào Define menu > Static Load Cases để định nghĩa các trường hợp tải trọng. Lưu ý 

rằng tùy loại, cấp, chiều cao công trình mà có thể có các trường hợp tải trọng khác nhau 

(gió động, động đất). 

- Vào Define menu > Load Combinations  để tổ hợp tải trọng theo tiêu chuẩn. 

- Vào Select menu(Select/by Frame sections, Select/by Wall/Slab…) hoặc có thể chọn 

từng cấu kiện theo bản vẽ kiến trúc mà cấu kiện đó chịu dạng tải khác nhau. Kết hợp 

Assign menu(Assign > rame/ Line Loads, Assign >Sell/ Area Loads…) để nhập tải trọng. 

- Nếu có sử dụng khối lượng trong mô hình tính toán (ví dụ để tìm các tần số và dao động 

tự nhiên,…) thì khai báo nguồn tạo ra khối lượng bằng cách vào Define menu > Mass 

Source. 

- Xem các thông tin của mô hình kết cấu đã dựng: vào Display menu > Show Loads và 

Display menu > Set Input Table Mode. Ta cũng có thể click chuột phải vào đối tượng cần 

xem thông tin thì màn hình sẽ xuất hiện ra một Form cung cấp các thông tin về đối tượng 

đã chọn. 

5.Hoàn thiện mô hình tính. 

- Vào Assign  › Joint/Point › Restraints(Supports) để gán liên kết chân cột. 
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- Chọn toàn bộ công trình bằng cách nhấn tổ hợp phím Ctrl+A hoặc chọn biểu tượng all 

trên thanh công cụ. Click vào menu Assign >  Shell/Area > Area Object Mesh 

Options...để chia nhỏ dầm sàn. 

- Click vào menu Assign > Shell/Area >  Diaphragms...để gán sàn tuyệt đối cứng. Trong 

trường hợp có tính đến gió động hoặc muốn gán tải trọng vào Diaphragms, cần nhấn phím 

F5 hoặc Analyze > Run Analyze để xuất hiện tọa độ các tâm(tâm cứng, tâm khối lượng, 

tâm hình học) sau đó mở khóa và nhập lại tải trọng ngang. 

- Xác lập các thông số phân tích (ví dụ, số bậc tự do của mô hình tính toán) trong Analyze 

menu > Set Analysis Options. 

- Nếu cần chia lưới thủ công cho sàn (Floor), tường/vách (Wall) hoặc mái dốc (Ramp) thì 

vào Edit menu > Mesh Areas. Thao tác này cũng có thể được dùng khi dựng mô hình. 

6.Chạy mô hình và xem kết quả. 

- Dùng Analyze menu > Run Analysis để phân tích kết cấu. Khi phân tích xong, nhớ kiểm 

tra xem phần mềm có thông báo lỗi gì hay không. 

- Hiển thị kết quả phân tích nội lực dưới dạng đồ họa: Vào Display >Show Member 

Forces/Stress Diagram >Frame/Pier/Spandrel Forces. 

- Vào File menu > Print Tables > Input nếu muốn in thông tin đã nhập cho mô hình ra 

máy in hay lưu thành File. Hoặc dùng File menu > Export > Save Input/Output as Access 

Database File để lưu thông tin thành File cơ sở dữ liệu có thể được xem, hiệu chỉnh và in 

trong phần mềm Microsoft Access. 

- Để in kết quả (dưới dạng bảng biểu), vào File menu > Print Tables > Analysis Output. 

Muốn lưu kết quả thành File cơ sở dữ liệu của phần mềm Access thì vào File menu > 

Export > Save Input/Output as Access Database File. 

-Vào menu Display>Show Table : hiển thị các kết quả có thể xuất sang Excel. 

+ Dầm : Tính dầm chịu mômen uốn chính theo (Momen 3-3) và Cắt chính (Shear 2-2). 

+ Cột :Cột tính cho bài toán kéo nén lệch tâm xiên, nội lực lấy Axial Force, Momen 3-3 

và Momen 2-2 

7.Thiết kế kết cấu. 

Bài toán thiết kế là nhiều bài toán kiểm tra 

-Chọn tiêu chuẩn thiết kế: Menu Option\Preference\Concrete Frame Design  

- Sử dụng các lệnh trong Design menu để thiết kế kết cấu (có thể phải tính lập vài lần).  

- Bắt đầu thiết kế : Design>Concrete Frame Design>Start Design/ Check of Structure. 

- Để xem các thông tin thiết kế, định vị chuột vào một phần tử nào đó và nhấn chuột phái, 

chương trình mở hộp thoại Concrete Design Information, cho biết các thông tin về cốt 
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thép dọc, thép đai trong từng mặt cắt. Muốn xem chi tiết hơn, nhấn vào các ô chứa Detail 

sẽ hiện hộp thoại mới và cho các thông tin sau : 

+Frame ID : Tên phần tử - Station ID : tên mặt cắt - Section ID : Tên tiết diện - Combo 

ID : Tên tổ hợp dùng cho thiết kế 

+Các giá trị liên quan đến tiết diện và tham số thiết kế của vật liệu : L, B, E, Fy, fc... 

+Các giá trị lực dùng cho thiết kế : P, M2,M3 và diện tích thép tương ứng (Rebar area) 

4.2.Ví dụ. 

Thực hành trực tiếp trên máy các ví dụ sau: 

4.2.1.Ví dụ 1:  

 

Automesh sàn khoảng cách 

lớn nhất là 1m 

 
 

MẶT BẰNG SÀN TẦNG 1, 2, 3, 4 

  

 Khung BTCT 04 tầng như 

hình vẽ. 

- Tầng 1 cao 4.5m, mỗi tầng 

còn lại cao 3.5m 

+ Dầm 200x400mm; 

+ Cột 250x400mm;  

+ Sàn dày 120mm; 

- Bê tông B15 có E = 2.3 

10
6
 T/m

2
 

 

 Các trường hợp tải trọng : 

(1) Tĩnh tải 

+ Trọng lượng bản thân kết cấu (hệ số vượt tải = 1.1) 

+ Các lớp hoàn thiện trên sàn: 150 kG/m
2
 (sàn 1, 2,3) và 230 

kG/m
2
 (sàn mái) 

+ Trọng lượng tường xây phân bố đều trên dầm tầng 1, 2, 3 : 

1T/m (dầm biên) và 0.5 T/m (dầm giữa) 

(2) Hoạt tải sử dụng: 240 kG/m
2
 (sàn 1, 2, 3) và 100 kG/m

2
 (sàn 

mái) 

(3) Hoạt tải gió: lực tập trung qui về tâm hình học của mỗi sàn 
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Tầng FX (T) FY (T) 

1 4.675 6.630 

2 6.375 9.180 

3 6.970 10.455 

4 3.825 5.525 
 

 

Các trường hợp tải Các tổ hợp 

Tên trường hợp 

tải 

Diễn giải Tổ hợp Cấu trúc 

(1a)  TLBT Trọng lượng bản thân(x1.1) COMB1 (TLBT + CTAO+TUONG) + HT 

(1b) CTAO 
Trọng lượng các lớp hoàn 

thiện 
COMB2 

TLBT + CTAO+TUONG + 0.9 ( 

HOATTAI + GIOX) 

(1c) TUONG 
Tải trọng tường tác dụng lên 

dầm 
COMB3 

TLBT + CTAO+TUONG + 0.9 ( 

HOATTAI + GIOXX) 

(2)  HOATTAI Hoạt tải thẳng đứng COMB4 
TLBT + CTAO+TUONG + 0.9 ( 

HOATTAI + GIOY) 

(3)  GIOX Gió phương X (trái ) COMB5 
TLBT + CTAO+TUONG + 0.9 ( 

HOATTAI + GIOYY) 

(4)  GIOXX Gió phương -X (phải ) COMB6 TLBT + CTAO+TUONG + GIOX 

(5)  GIOY Gió phương Y (trước ) COMB7 TLBT + CTAO+TUONG + GIOXX 

(6)  GIOYY Gió phương –Y (sau ) 

COMB8 TLBT + CTAO+TUONG + GIOY 

COMB9 TLBT + CTAO+TUONG + GIOYY 

BAO 
Bao của (COMB1 , COMB2 , ..., 

COM B9) 

 

Yêu cầu 

1. Vẽ biểu  đồ momen uốn của dầm tầng 1 khung trục B với tổ hợp COMB1 (vẽ từ trục 

dầm) 

2. Vẽ biều đồ lực dọc cột trục B-2 với tổ hợp COMB3 

3. Hãy vẽ chiều và truyền giá trị phản lực tại chân cột trục B-1, C-2 với COMB1 để tính 

toán móng đơn cho công trình. 

4.2.2.Ví dụ 2:  

-Một công trình có mặt bằng như hình vẽ, gồm 15 tầng và 1 tầng hầm, chiều cao của tầng 

là 3,5m, tầng hầm cao 3m. Giả thiết tường gạch xây trên tất cả các dầm, tường dày 200. 
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Tải trọng: tĩnh tải của các lớp hoàn thiện lên sàn 0,15 T/m2. Hoạt tải tính toán sàn làm 

việc 0,24 T/m2; hoạt tải sàn mái 0,09 T/m2. Tĩnh tải do tường tác dụng lên dầm: 1,05 

T/m. Chọn sơ bộ kích thước tiết diện: sàn dày 150; dầm bxh = 300x600; vách dày 250. 

Base ÷ story 3 Story 4 ÷ story 6 Story 7 ÷ story 9 Story 10 ÷ story12 Story 13 ÷ story 16 

800x800 700x700 600x600 500x500 400x400 

 

 

4.2.2.Ví dụ 3: 
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CHƢƠNG 5. BÀI TOÁN THIẾT KẾ NHÀ CÔNG NGHIỆP. 

 

5.1.Các bƣớc thực hiện thiết kế nhà công nghiệp. 

1.Xây dựng hệ lƣới. 

- Định đơn vị (lực và chiều dài). Nên chọn đơn vị nào mà sử dụng thường xuyên trong 

quá trình mô hình kết cấu như Ton-m; KN-m…, mặc dù có thể đổi đơn vị sử dụng bất kỳ 

lúc nào ta muốn. 

- Bắt đầu tạo mô hình, vào File menu > New Model, chọn một trong những phương pháp 

khởi tạo mô hình. 

- Thiết lập hệ thống lưới(Grid lines). Hệ lưới này căn cứ chủ yếu vào bản vẽ kiến trúc của 

công trình(số trục theo 2 phương, số tầng, chiều cao…). Trong tài liệu này chủ yếu đề cập 

đến tính khung phẳng cho nhà công nghiệp nên số trục theo phương Y nhập là 1.  

2.Khai báo đặc trƣng vật liệu và tiết diện của phần tử. 

- Vào Define>Material Properties để định nghĩa các đặc trưng cơ học của vật liệu. Trong 

mục Define Material chọn Steel. Một vài đặc trưng của vật liệu như: 

Mass per unit Volumn: là khối lượng riêng (nhập 0.785) 

Weight per unit Volumn: là trọng lượng riêng (nhập 7.85 Tấn/m
3
) 

Modulus of Elasticity: là mô đun đàn hồi (E=2.06x10
6
 kg/cm

2
 ) 

- Vào Define>Frame sections để định nghĩa tiết diện phần tử dầm, cột. Lưu ý rằng có 

nhiều loại tiết diện thép như I, C, U, H, V, L, O… 

Với tiết diện chữ I: 

+ Outside height (t3): Chiều cao bản bụng 

+ Top flange width (t2): Chiều rộng bản cánh trên 

+ Top flange thickness (tf): Chiều dày bản cánh trên 

+ Web thickness (tw): Chiều dày bản bụng 

+ Buttom flange width (t2): Chiều rộng bản cánh dưới 

+ Buttom flange thickness (tf): Chiều dày bản cánh dưới 

- Vào Define>Frame sections>Add Nonprismatic để khai báo tiết diện thay đổi. 

- Vào Select menu và Assign menu để hiệu chỉnh các tiết diện nếu muốn. 

3.Vẽ và hiệu chỉnh mô hình. 

- Vẽ các đối tượng Line (đường) và Point (điểm) bằng cách dùng các biểu tượng hoặc vào 

menu để tạo mô hình. 

- Có thể hiệu chỉnh sơ đồ kết cấu như mong muốn bằng cách dùng lệnh trong Edit menu. 
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- Dùng các lệnh trong Assign menu để hiệu chỉnh các đặc trưng của các đối tượng phần tử 

(hình dạng, kích thước tiết diện, khối lượng, tải trọng, giải phóng momen, liên kết nửa 

cứng,…). Cần chọn trước phần tử rồi mới thực hiện các lệnh gán trong Assign menu cho 

các phần tử đã chọn đó. 

- Dùng các lệnh trong View menu  Set Building View Options để cho hiện hoặc tắt các 

thông tin nào đó (ví dụ tiết diện, giải phóng momen, khớp dẻo,…) 

- Vào Options menu > Preferences để thay đổi các tùy chọn mặc định (nếu muốn), ví dụ 

kích cỡ chữ, tiêu chuẩn thiết kế sẽ sử dụng,… 

4.Khai báo tải trọng và tổ hợp tải trọng. 

- Vào Define menu > Static Load Cases để định nghĩa các trường hợp tải trọng. Lưu ý 

rằng nhà công nghiệp có tải trọng cầu trục. 

- Vào Define menu > Load Combinations  để tổ hợp tải trọng theo tiêu chuẩn. 

- Chọn từng cấu kiện theo bản vẽ kết cấu mà cấu kiện đó chịu dạng tải khác nhau. Kết 

hợp Assign menu(Assign >Joint/ Point Loads, Assign > rame/Line Loads …) để nhập tải 

trọng. 

- Xem các thông tin của mô hình kết cấu đã dựng: vào Display menu > Show Loads và 

Display menu > Set Input Table Mode. Ta cũng có thể click chuột phải vào đối tượng cần 

xem thông tin thì màn hình sẽ xuất hiện ra một Form cung cấp các thông tin về đối tượng 

đã chọn. 

5.Hoàn thiện mô hình tính. 

- Vào Assign  › Joint/Point › Restraints(Supports) để gán liên kết chân cột. 

- Xác lập các thông số phân tích (ví dụ, số bậc tự do của mô hình tính toán) trong Analyze 

menu > Set Analysis Options. 

6.Chạy mô hình và xem kết quả. 

- Dùng Analyze menu > Run Analysis để phân tích kết cấu. Khi phân tích xong, nhớ kiểm 

tra xem phần mềm có thông báo lỗi gì hay không. 

- Hiển thị kết quả phân tích nội lực dưới dạng đồ họa: Vào Display >Show Member 

Forces/Stress Diagram >Frame/Pier/Spandrel Forces. 

- Vào File menu > Print Tables > Input nếu muốn in thông tin đã nhập cho mô hình ra 

máy in hay lưu thành File. Hoặc dùng File menu > Export > Save Input/Output as Access 

Database File để lưu thông tin thành File cơ sở dữ liệu có thể được xem, hiệu chỉnh và in 

trong phần mềm Microsoft Access. 
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- Để in kết quả (dưới dạng bảng biểu), vào File menu > Print Tables > Analysis Output. 

Muốn lưu kết quả thành File cơ sở dữ liệu của phần mềm Access thì vào File menu > 

Export > Save Input/Output as Access Database File. 

-Vào menu Display>Show Table : hiển thị các kết quả có thể xuất sang Excel. 

+ Dầm : Tính dầm chịu mômen uốn chính theo (Momen 3-3) và Cắt chính (Shear 2-2). 

+ Cột :Cột tính cho bài toán kéo nén lệch tâm xiên, nội lực lấy Axial Force, Momen 3-3 

và Momen 2-2 

7.Thiết kế kết cấu thép. 

Khai báo vật liệu: fy: Cường độ giới hạn chảy; Trình tự thực hiện : giống như kết cấu 

BTCT Kiểu phần tử. 

-Column: Phần tử này song song phương Z 

-Beam : Phần tử song song mặt phẳng XY 

-Giằng (Braced) 

-(Effective Length Factor (K)): phụ thuộc vào liên kết (Phần tử, gối tựa, restraint, 

phuơng). Etabs tự động tính K (Liên kết nút, phần tử). Mặc định không xác định được 

kiểu liên kết lấy= 1. 

5.2.Ví dụ. 

Thực hành trực tiếp trên máy dựng mô hình của các công trình sau. 

Ví dụ 1: Nhà công nghiệp 1 nhịp 1 tầng. 

Bảng Các thông số về cầu trục: 

Sức 

trục 

Q(T) 

Nhịp 

cầu 

trục 

Lk(m) 

Kích thước gabarit 

chính (mm) 

 

Trọng lượng 

(T) 

áp lực bánh xe  

lên ray (kN) 

Hk Zmin Bk K Cầu trục(G) 
Xe 

con(Gxc) 
Pmax

c
 Pmin

c 

6,3 22,5 810 160 3880 3200 9,22 0,59 48,7 16,7 

 

Các kích thƣớc chính của khung ngang: 

a. Theo phƣơng đứng 

- Chiều cao từ mặt ray cầu trục đến đáy xà ngang: 

    
2 K K 

H H b 0,81 0,3=1,11 m  

Với: HK = 0,81 m – chiều cao gabarit của cầu trục. 

       bK = 0,3 m – khe hở an toàn giữa cầu trục và xà ngang. 
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  Chọn H2  = 1,2 (m) 

- Chiều cao cột khung tính từ mặt móng đến đáy xà ngang: 

       
1 2 3

H H H H 7,4 1,2 0 8,6 m        

Trong đó:  H1 - cao trình đỉnh ray, H1 = 7,4 m; 

H3 - phần cột chôn dưới nền,coi mặt móng ở cốt ± 0,000( H3 = 0) 

- Chiều cao của phần cột trên, tính từ vai cột đỡ dầm cầu trục đến đáy xà ngang: 

       
t 2 dct r

H H H H 1,2 0,7 0,2 2,1 m   

- Chiều cao của phần cột dưới, tính từ mặt móng đến mặt trên của vai cột: 

      
d t

H H-H 8,6 2,1 6,5 m                    

b. Theo phƣơng ngang:  

- Nhịp cầu trục: LK = 22,5 (m) 

- Chiều cao tiết diện cột chọn theo yêu cầu về độ cứng: 

  
   

         
   

1 1 1 1
h H 8,6 0,43 0,573 m

15 20 15 20
;       Chọn h = 40(cm) 

- Kiểm tra khe hở giữa cầu trục và cột khung: 

         
min

z l a h 0.75 0 0,4 0,35m z 0,16 m  

Sơ đồ kết cấu khung ngang nhà công nghiệp: 

 

750

24000

mÆt c¾t ngang nhµ

i = 10%

q = 63kn

a

± 0.00

+ 6,5

+ 7,4

+ 8,6

i = 10%

b

2
1
0
0

6
5
0
0

8
6
0
0

750
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c. Sơ đồ tính khung ngang 

 

Giả thiết tiết diện: 

- Cột:  ,      
w f

H 8600mm,h 400mm,b 200mm,t 7mm,t 10mm 

- Xà ngang có kích thước : 

Đầu xà:     
w f

h 400mm,b 200mm,t 7mm,t 10mm  

Đỉnh xà:    
w f

h 250mm,b 200mm,t 7mm,t 10mm  

Giữa xà:    
w f

h 250mm,b 200mm,t 7mm,t 10mm  

Các tải trọng tác dụng: 

- Tĩnh tải: 

 

1,0725kN/m9,224kN

6,825kN

3,754kNm

9,224kN

6,825kN

3,754kNm

1,0725kN/m
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- Hoạt tải: Hoạt tải nửa mái trái, phải, cả mái: 

 

   

 

2,535kN/m

2,535kN/m

2,535kN/m2,535kN/m
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        - Hoạt tải gió: Hoạt tải do gió trái, phải: 

 

 

      - Hoạt tải do Áp lực đứng của cầu trục Dmax lên cột trái: 

 

3
,3

1
7

k
N

/m

2
,0

7
3

k
N

/m

1,683kN/m1,57kN/m

1,57/m1,683kN/m

3
,3

1
7
k
N

/m

2
,0

7
3
k
N

/m

127,78kN

70,28kNm

43,82kN

24,10kNm
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- Hoạt tải do Áp lực đứng của cầu trục Dmax lên cột phải: 

  

- Hoạt tải do lực hãm ngang cầu trục lên cột trái: 

 

- Hoạt tải do lực hãm ngang cầu trục lên cột phải: 

  

43,82kN

24,10kNm

127,78kN

70,28kNm

4,52kN

4,52kN
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Tổ hợp Cấu trúc Tổ hợp Cấu trúc 

COMB1 TT +  HTTRAI COMB7 TT + 0.9(HTTRAI + GIOPHAI) 

COMB2 TT + HTPHAI COMB8 TT + 0.9(HTPHAI + GIOTRAI) 

COMB3 TT + HTCD COMB9 TT + 0.9(HTPHAI + GIOPHAI) 

COMB4 TT + GIOTRAI COMB10 TT + 0.9(HTCD + GIOTRAI) 

COMB5 TT + GIOPHAI COMB11 TT + 0.9(HTCD + GIOPHAI) 

COMB6 
TT + 0.9(HTTRAI + 

GIOTRAI) 
BAO 

Bao của (COMB1, COMB2, COMB3, 

COMB4, …COMB11) 

 

Khi có cầu trục, xét thêm các tổ hợp: 

Tổ hợp Cấu trúc 

COMB12 TT +  HTTRAI+Tmax
tr 

+Dmax
tr 

COMB13 TT +  HTTRAI+Tmax
ph 

+Dmax
tr 

COMB14 TT +  HTTRAI+Tmax
tr 

+Dmax
ph 

COMB15 TT +  HTTRAI+Tmax
ph 

+Dmax
ph 

COMB16 TT + HTPHAI+Tmax
tr 

+Dmax
tr 

COMB17 TT + HTPHAI+Tmax
ph 

+Dmax
tr 

COMB18 TT + HTPHAI+Tmax
tr 

+Dmax
ph 

COMB19 TT + HTPHAI+Tmax
ph 

+Dmax
ph 

COMB20 TT + HTCD+Tmax
tr 

+Dmax
tr 

COMB21 TT + HTCD+Tmax
ph 

+Dmax
tr 

COMB22 TT + HTCD+Tmax
tr 

+Dmax
ph 

COMB23 TT + HTCD+Tmax
ph 

+Dmax
ph 
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………….. ………………. 

………….. ………………. 

 

Ghi chú: Không nên khai báo tổ hợp dạng này mà nên xuất nội lực ra bảng Excel rồi lập 

bảng tổ hợp nội lực. 

 

Ví dụ 2: Nhà công nghiệp 3 nhịp 1 tầng. 

Cho kích thước Gabarit của khung ngang. 

Theo phương đứng 

- Chiều cao H2 từ đỉnh ray cầu trục đến cao trình cánh dưới rường(xà ngang): 

                 H2 = Hk + bk  

Trong đó: Hk  Chiều cao Gabarit cầu trục,tra catalo cầu trục  Hk = 1330 mm  

  bk  = 200 mm: Khe hở an toàn giữa xe con và kết cấu 

   H2 = 1330 + 200  = 1530 mm 

- Chiều cao từ cao trình mặt nền đến  cánh dưới thấp nhất của rường là: 

  H = H1 + H2+H3                         

Trong đó: H1=7400mm : Chiều cao từ mặt nền đến cao độ mặt ray 

H3=0: phần cột chôn dưới nền,coi mặt móng ở cốt  0.000 

  H = 7400 + 1530 = 8930 mm 

- Chiều cao phần cột trên: 

  Htr = H2 + Hdct + Hr  

Trong đó: Hdct: Chiều cao của dầm cầu trục. Hdct = 524 mm 

  Hr: Chiều cao  của ray và lớp đệm. Hr = 146 mm 

  Htr = 1530 + 524 + 146 = 2200 mm 

- Chiều cao phần cột dưới: 

  Hd = H  - Htr +H4 

  Hd = 8930 – 2200 +600 = 7330 mm 

Trong đó: H4: Phần cột chôn dưới mặt nền, lấy H4 = 600 mm 

- Cao trình đỉnh mái. 

  M = H + Hr + t + hdr 

Trong đó: Hr - Chiều cao giữa rường, Hr = 0,9 m. 

   t - Tổng chiều dày các lớp mái (xà gồ, tấm lợp, lớp cách nhiệt) 

   t = 0,2 + 0,65 + 0,07 = 0,2657 m. 

   hdr - Chiều cao đỉnh rường. Dự kiến chọn hdr = 500 mm. 

   M = 8930 + 900 + 265,7 + 500 = 10595,7 mm  = 10,6 m. 

- Cao trình đỉnh tường. 
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  M’ = H + t + hdr. = 8930 + 265,7 + 500 = 9695,7 mm  = 9,7 m.  

        Kích thước theo phương ngang 

- coi Trục định vị trùng với mép ngoài của cột(a=0). Khoảng cách từ trục định vị 

đến trục ray cầu trục:  

k
1

L L 18 16,5
L 0,75

2 2

 
                         

Chiều cao tiết diện cột chọn theo yêu cầu độ cứng: 

 
1 1 1 1

h H 8,93 0,595 0,4465
15 20 15 20

   
        
   

 

Chọn hc= 450 mm  đối với cột biên. 

Chọn hc= 500 mm  đối với cột giữa. 

Kiểm tra khe hở giữa cầu trục và cột khung: 

                                   z=L1-h =0,75-0,5=0,25>zmin=0,16 

Từ số liệu đầu bài và căn cứ vào điều kiện cấu tạo ta chọn sơ bộ kích thước tiết diện 

và các kích thước chính của khung ngang như hình vẽ. 

 

 

Các kích thước chính của khung ngang. 

 

g e
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Mô hình hóa sơ đồ hệ khung phẳng, các thanh liên kết với nhau bằng các nút cứng 

và chân cột liên kết ngàm với móng. Sơ đồ tính khung và thứ tự qui ước phần tử các thanh 

như hình vẽ dưới.  

 

 
 

Sơ đồ tính khung. 

- Giả thiết cột có kích thước như sau: 

+ Cột biên: H 9530mm , mm450h  , wt 8mm , b 250mm , ft 12mm . 

+ Cột giữa: H 9530mm , h 500mm , wt 8mm , b 250mm , ft 12mm . 

- Rường ngang có kích thước: 

+ Đầu rường:  h 450mm , b 200mm , wt 8mm , ft 10mm  

+ Đỉnh rường: h 250mm , b 200mm , wt 8mm , ft 10mm  

Bảng tổng hợp các giá tri tải trọng tác dụng lên khung. 

TÊN TẢI TRỌNG 
KÝ 

HIỆU 
DẠNG TẢI TRỌNG 

GÍA TRỊ 

TIÊU 

CHUẨN 

GÍA TRỊ 

TÍNH TOÁN 

TĨNH TẢI 

q Phân bố trên rờng ngang  
 135,84 

(kG/m) 

N Tập trung đỉnh cột   856(kG) 

Gdct Tập trung vai cột    768(kG) 

Mdct Tập trung vai cột    403(kGm) 

HOẠT TẢI MÁI P Phân bố trên rường ngang    234(kG/m) 

HOẠT TẢI ĐỨNG 

CẦU TRỤC 

Dmax Tập trung vai cột    29930(kG) 

Dmin Tập trung vai cột    596(kG) 

Mmax1 Tập trung vai cột biên    15713(kGm) 

Mmin1 Tập trung vai cột biên    3129(kGm) 

Mmax2 Tập trung vai cột giữa     22447(kGm) 

Mmin2 Tập trung vai cột giữa    4470(kGm) 

HOẠT TẢI 

NGANG CẦU 

TRỤC 

Tmax 
Tập trung cao trình dầm 

hãm 
   1330(kG) 



 

88 

 

GIÓ 

qd Phân bố trên cột     541,7(kG/m) 

qh Phân bố trên cột    308,1(kG/m) 

qe1 Phân bố trên rường ngang    109,4(kG/m) 

qe2 Phân bố trên rường ngang    342(kG/m) 

qe3 Phân bố trên rường ngang    342 (kG/m) 

qe4 Phân bố trên rường ngang   342 (kG/m) 

qe5 Phân bố trên rường ngang    342 (kG/m) 

qe6 Phân bố trên rường ngang    342 (kG/m) 

 

Yêu cầu:  Xác định nội lực khung, nội lực các phần tử thanh ứng với các trường hợp 

tải. 

+ Xuất biểu đồ nội lực tương ứng với các trường hợp tải dạng ảnh đen trắng. 

 

 

Tải trọng do tĩnh tải. 

 

 
 

Tải trọng do hoạt tải mái nửa trái. 

 



 

89 

 

 
 

Tải trọng do hoạt tải mái nửa phải. 

 

 
 

Tải trọng do hoạt tải mái pa 1 

 
 

Tải trọng do hoạt tải mái pa 2 

 

 
 

Tải trọng do hoạt tải mái pa 3 
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Tải trọng do Dmax  1 

 

 
 

Tải trọng do Dmax  2 

 

 

 
 

Tải trọng do Dmax  3 
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Tải trọng do Dmax  4 

 

 
 

Tải trọng do Dmax  5 

 

 
 

Tải trọng do Dmax  6 

 

 
 

Tải trọng do Tmax 1 

 

 
 

Tải trọng do Tmax 2 
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Tải trọng do Tmax 3 

 
 

Tải trọng do Tmax 4 

 

 
 

Tải trọng do Tmax 5 

 

 
 

Tải trọng do Tmax 6 
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Tải trọng do gió trái 

 
 

Tải trọng do gió phải 

 

 

 

Tổ hợp nội lực 

Ta xét 2 loại tổ hợp 

- Tổ hợp cơ bản 1: gồm tĩnh tải thường xuyên và 1 hoạt tải 

- Tổ hợp cơ bản 2: gồm tải trọng thường xuyên và nhiều hoạt tải nhân với hệ số tổ 

hợp 0,9. Trong trường hợp nội lực do tải trọng của 4 cầu trục cùng tác dụng lên một cột 

được nhân thêm hệ số tổ hợp 0,7. Kết quả cụ thể được ghi trong bảng tổ hợp. 

Từ kết quả tính toán nội lực như trên ta tìm ra trường hợp nội lực bất lợi nhất để tính 

toán tiết diện khung. Với cột ta xét 4 tiết diện: chân cột, vai cột (2tiết diện), đầu cột. Với 

rường ngang ta xét 3 tiết diện: đầu rường, 1/3 rường, đỉnh rường. Tại mỗi tiết diện có các 

trị số M, N, V. 
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CHƢƠNG 6 : KẾT HỢP AUTOCAD, EXCEL, ACCESS, ETAB TỰ ĐỘNG 

HÓA THIÉT KÉ 

6.1.Xuất kết quả ra access 

1.Các bước xuất kết quả . 

2.Lọc xử lý kết quả bằng query trong Access . 

6.2.Chu trình tính tóan dàn thép bằng CAD, Access, Excel. 

1.Tạo mô hình trong Cad 

-Thông thường, lấy luôn bản vẽ CAD 2D từ kiến trúc gửi sang cho nhóm kết cấu. 

-Sửa lại và nhóm các thanh thành các layer có tính chất giống nhau (dựa trên tiết diện 

chọn sơ bộ ban đầu, mỗi tiết diện vào một layer). 

2.Nhập mô hình vào trong Etabs. 

-Định nghĩa tiết diện trong CAD 

-Xác định đơn vị tính. 

-File^Inport^DXF file, chọn file SAPDXF.DXF chứa trong thư mục Etabs 

-Import lần lượt từng layer một vào trong Etabs. Tương ứng với từng layer ta chọn một 

tiết diện đã định nghĩa ở bước trước. 

-Sau khi import tất cả sơ đồ tính, ta được mô hình hình học. 

-Gán các điều kiện biên cần thiết. 

-Định nghĩa tải trọng và gán tải trọng cho kết cấu… 

-Chạy ra nội lực của các thanh. 

3.Xử lý kết quả ằng Excel 

Export tất cả mô hình cùng kết quả tính toán sang excel. F i l eexpor t^  Etabs MS 

Excel Spreadsheet XLS file, đánh dấu vào tất cả các bảng. 

Lập bảng tính trong Excel, dựa vào nội lực đã có trong các thanh giàn, kiểm tra ổn 

định của các thanh. Đối với những thanh không đủ khả năng chịu lực ->tăng tiết diện. Đối 

với những thanh nội lực quá bé ->giảm tiết diện xuống. 

Quay lại file vừa xuất kết quả trên. Sửa những lại tiết diện của những thanh cần sửa 

trong sheet “Frame Section Assignments”. 

4.Nhập lại mô hình vào trong Etabs 

File^import^ Etabs MS Excel Spreadsheet XLS file. Khi đó bạn đã có toàn bộ mô 

hình vừa xuất ra kèm theo các tiết diện đã thay đổi. 

Bước tiếp theo chỉ việc chạy chương trình để nhận được kết của nội lực mới. 

5.Lặp lại chu trình đến khi đạt kết quả . 

Lặp lại chu trình trên đến khi bạn cảm thấy kết quả nội lực trong các thanh là hợp lý. 
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